Important User Information

Read this document and the documents listed in the additional resources section about installation, configuration, and operation of this equipment before you install, configure, operate, or maintain this product. Users are required to familiarize themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

| WARNING: | Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may lead to personal injury or death, property damage, or economic loss. |
| ATTENTION: | Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence. |
| IMPORTANT | Identifies information that is critical for successful application and understanding of the product. |

Labels may also be on or inside the equipment to provide specific precautions.

| SHOCK HAZARD: | Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage may be present. |
| BURN HAZARD: | Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach dangerous temperatures. |
| ARC FLASH HAZARD: | Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory requirements for safe work practices and for Personal Protective Equipment (PPE). |

Rockwell Automation recognizes that some of the terms that are currently used in our industry and in this publication are not in alignment with the movement toward inclusive language in technology. We are proactively collaborating with industry peers to find alternatives to such terms and making changes to our products and content. Please excuse the use of such terms in our content while we implement these changes.
# Summary of changes

This publication contains the following new or updated information. This list includes substantive updates only and is not intended to reflect all changes.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Reason for change</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web page for installing the FactoryTalk AssetCentre client and agent cannot be shown</td>
<td>Installing FactoryTalk AssetCentre client or agent from a webpage hosted on the FactoryTalk AssetCentre server is no longer supported.</td>
</tr>
<tr>
<td>Perform silent or unattended installation on page 76</td>
<td>Update command-line examples.</td>
</tr>
<tr>
<td>Install Microsoft SQL Server on page 19</td>
<td>Update the selection of SQL Server features.</td>
</tr>
<tr>
<td>Command-line parameters for silent or unattended installation on page 78</td>
<td>/sql is required when using SQL Authentication between the FactoryTalk AssetCentre and Microsoft SQL Servers.</td>
</tr>
</tbody>
</table>
Chapter 1
Introduction

About FactoryTalk AssetCentre ...................................................................................................................... 11
  FactoryTalk Services Platform .................................................................................................................. 11
About the documentation set .......................................................................................................................... 11
  About this book ......................................................................................................................................... 12
The components of FactoryTalk AssetCentre ............................................................................................... 12
System requirements ...................................................................................................................................... 13
  Hardware requirements ........................................................................................................................... 13
  Product compatibility ................................................................................................................................ 14
  Operating systems ..................................................................................................................................... 15
  Software requirements ............................................................................................................................. 16
  Network requirements .............................................................................................................................. 17
About the installation process ....................................................................................................................... 18

Chapter 2
Install the FactoryTalk AssetCentre Server software

Before you install the FactoryTalk AssetCentre Server ................................................................................. 19
  Ensure that the current Windows user has administrative rights ........................................................ 19
Install Microsoft SQL Server .................................................................................................................... 19
  Minimum Microsoft SQL Server permissions ................................................................................. 21
Configure the certificate for encrypted connection to the database.................................................... 21
  Configure a certificate on the SQL Server computer ...................................................................... 22
  Configure a certificate on the FactoryTalk AssetCentre server computer .................................... 23
Create a self-signed TLS certificate on the SQL Server computer ................................................. 23
Create and install a standalone managed service account or group managed service account ...... 24
Steps to install the FactoryTalk AssetCentre Server .................................................................................... 25
  Step 1: Launch the Setup wizard and select what to install ................................................................... 26
  Step 2: Configure the FactoryTalk AssetCentre Server ......................................................................... 27
  Step 3: Read and accept license agreements .......................................................................................... 28
  Step 4: Configure TLS setting .................................................................................................................. 28
  Step 5: Start the installation .................................................................................................................... 29
  Step 6: Finish the installation .................................................................................................................. 29
After installation of FactoryTalk AssetCentre Server software ............................................................. 29

Chapter 3
Install FactoryTalk AssetCentre Agent software
# Table of Contents

Before you install the FactoryTalk AssetCentre Agent software .................................................................. 31
   Enable .NET Framework 3.5 features ......................................................................................................... 31
Steps to install the FactoryTalk AssetCentre Agent software ...................................................................... 32
   Step 1: Launch the Setup wizard and select what to install ................................................................... 32
   Step 2: Read and accept license agreements .......................................................................................... 34
   Step 3: Start the installation ..................................................................................................................... 34
   Step 4: Finish the installation .................................................................................................................. 35
   Configure for security-enabled Rockwell Automation software .......................................................... 35
      If operating in a Windows workgroup ............................................................................................. 35
After installation of FactoryTalk AssetCentre Agent software ..................................................................... 36

## Chapter 4

### Install FactoryTalk AssetCentre Client software

Before you install FactoryTalk AssetCentre Client software .................................................................. 39
   Where to install FactoryTalk AssetCentre Client software ................................................................... 39
Steps to install FactoryTalk AssetCentre Client software ............................................................................ 40
   Step 1: Launch the Setup wizard and select what to install ................................................................... 40
   Step 2: Read and accept license agreements ........................................................................................... 41
   Step 3: Start the installation ..................................................................................................................... 42
   Step 4: Finish the installation .................................................................................................................. 42
After installation of FactoryTalk AssetCentre Client software ..................................................................... 42

## Chapter 5

### Custom install the FactoryTalk AssetCentre software

## Chapter 6

### Install the AssetCentre Diagnostics Connector

Steps to install the AssetCentre Diagnostics Connector ............................................................................. 45
   Step 1: Launch the Setup wizard and select what to install ................................................................... 45
   Step 2: Read and accept license agreements .......................................................................................... 46
   Step 3: Start the installation ..................................................................................................................... 46
   Step 4: Finish the installation .................................................................................................................. 46

## Chapter 7

### Upgrade FactoryTalk AssetCentre

Back up FactoryTalk AssetCentre with Microsoft SQL Server .................................................................... 50
Restore FactoryTalk AssetCentre in Microsoft SQL Server 2019 ................................................................. 61
Use Data Source Configuration Wizard to update a SQL user account ..................................................... 65
## Move existing database to new server

- Move existing database to new server ........................................................................................................... 70

## Optional software upgrades

- Optional software upgrades............................................................................................................................ 71

## Chapter 8

**Use silent or unattended setup to install the FactoryTalk AssetCentre software**

- Before performing the silent or unattended installation .................................................................................. 74
  - Before you install the FactoryTalk AssetCentre Server software using silent or unattended setup .............. 74
  - Before you install FactoryTalk AssetCentre Agent software using silent or unattended setup ................. 75
  - Before you install the FactoryTalk AssetCentre Client software using silent or unattended setup .......... 75
- Perform silent or unattended installation ........................................................................................................ 76
- Command-line parameters for silent or unattended installation .................................................................... 78
- After the installation using the unattended setup .......................................................................................... 81

## Chapter 9

**Configure the TLS protocol for FactoryTalk AssetCentre**

- Install a TLS certificate ........................................................................................................................................... 83
- Configure the HTTPS site binding ........................................................................................................................ 84
- Configure a firewall rule and web services URL if the default port is modified ............................................... 84

## Chapter 10

**Configure Windows Authentication**

- Turn on Windows Authentication mode in Internet Information Services (IIS) .................................................. 89

## Chapter 11

**Configure FactoryTalk AssetCentre**

- Configure for client access to the server ............................................................................................................ 93
  - Add users to the FactoryTalk Directory ........................................................................................................... 93
  - Add computers to the FactoryTalk Directory ................................................................................................. 94
- Configure feature security for FactoryTalk AssetCentre users ........................................................................ 95
  - Policy settings and their functions ................................................................................................................ 96

## Chapter 12

**About FactoryTalk AssetCentre Web Client**

- Access FactoryTalk AssetCentre Web Client .................................................................................................... 99
- Configure Idle Time-out property in Internet Information Services (IIS) Manager ........................................... 99

## Chapter 13

**Uninstall FactoryTalk AssetCentre**
Chapter 14

Troubleshoot FactoryTalk AssetCentre

General installation ......................................................................................................................... 103
  A red x appears next to an item to be installed............................................................................. 103
  A Program Maintenance window appears ..................................................................................... 103

Server installation .......................................................................................................................... 103
  SQL collation error encountered during database installation .................................................... 103
  Change the FactoryTalk AssetCentre SQL server instance ......................................................... 104
  Unable to log on to SQL Server during server installation ......................................................... 104
  The application failed to initialize properly .................................................................................... 104

Client and agent installation ......................................................................................................... 105
  Check whether the client is installed correctly .............................................................................. 105
  Check whether the agent software is current ................................................................................ 105
  Error reading Primary Server Name from FactoryTalk Directory .............................................. 106
  Logged in user is not part of the Administrators group .............................................................. 106

Start the client ............................................................................................................................... 106
  Error initializing FactoryTalk AssetCentre .................................................................................... 106
  Error initializing FactoryTalk AssetCentre: unable to connect to the remote server ................. 107
  Error initializing FactoryTalk AssetCentre: the underlying connection was closed ................ 107
  Error initializing FactoryTalk AssetCentre: the remote server returned error (404) Not Found ... 108
  Error initializing FactoryTalk AssetCentre: the remote name could not be resolved............... 109
  Error initializing FactoryTalk AssetCentre: the remote server returned an error (401) Unauthorized .............................................................. 109

  The client and server versions are incompatible ......................................................................... 110
  Cannot initialize application eventing subsystem or No connection could be made because the target machine actively refused it ....................................................................................... 110
  At least one service or driver failed during system startup. Use Event Viewer to examine the event log for details .................................................................................................................. 110
  If the FactoryTalk AssetCentre server is installed to a drive other than C: ................................ 111
  Other errors starting the client .................................................................................................... 111

Start the agent .................................................................................................................................. 112

Appendix A

Configure the TLS protocol using a self-signed certificate

Create a self-signed TLS certificate .............................................................................................. 113
Export the created TLS certificate for FactoryTalk AssetCentre client and agent computers ........ 116
Configure a site binding ............................................................................................................................... 118
Configure SSL settings for Management of Change, FactoryTalk AssetCentre Client and Agent, and
FactoryTalk AssetCentre Web Client ............................................................................................................. 120
Turn on secure communication between the server, client(s), and agent(s) ............................................ 123
Import the self-signed TLS certificate to client and agent computers...................................................... 123

Legal Notices
Legal Notices .................................................................................................................................................. 131

Index
Chapter 1

Introduction

About FactoryTalk AssetCentre

FactoryTalk® AssetCentre monitors your factory automation system and provides centralized tools to minimize downtime due to unauthorized actions or failing devices. It does this by:

- Providing version control and archiving of program files and documents.
- Providing a disaster recovery system that verifies your devices' program and configuration files against protected master files, ensuring quick and accurate recovery if a problem should occur (optional Disaster Recovery capability).
- Monitoring FactoryTalk-enabled software products and logging system events and user actions (recorded in the Event log and Audit log respectively).
- Assets Lifecycle, which provides the life-cycle status of hardware devices by synchronizing life-cycle information in the FactoryTalk AssetCentre server and client with the data on the Rockwell Automation life cycle website.
- Managing device configuration files.

FactoryTalk Services Platform

FactoryTalk AssetCentre uses the FactoryTalk Services Platform to provide seamless connectivity with other FactoryTalk-enabled software. Customers and computers are defined in the FactoryTalk Directory; access to user actions within the FactoryTalk AssetCentre system is controlled within FactoryTalk Security.

About the documentation set

The documentation set includes:

- **FactoryTalk AssetCentre Installation Guide** (Document ID FTAC-IN005). Use this manual to install the FactoryTalk AssetCentre system. This manual is also available in the FactoryTalk AssetCentre installation package in 12.00.00-FTAssetCentre\\Docs. The file name is FTAC-InstallGuide.pdf. You can find it in Rockwell Automation Literature Library.
- **Help.** Use the comprehensive Help for assistance while using the FactoryTalk AssetCentre system.
- **FactoryTalk AssetCentre Getting Results Guide** (Document ID FTAC-GR002). Use this manual to get started with the FactoryTalk AssetCentre system. You can find it in Rockwell Automation Literature Library.
- **FactoryTalk AssetCentre Utilities User Manual** (Document ID FTAC-UM001). Use this manual for assistance while using an array of utilities whose capabilities are not present in the FactoryTalk AssetCentre system. You can find it in Rockwell Automation Literature Library.
About this book

This book is written for FactoryTalk AssetCentre administrators and IT professionals. To perform many of the tasks described in this book, you need to log on to the computers onto which you are installing software as an Administrator, or log on using an account that has administrative privileges.

We assume you are familiar with:

- Microsoft® Windows® operating systems including basic Windows networking and administration tasks
- Microsoft SQL Server
- RSLinx® Classic and FactoryTalk® Linx communication software
- Rockwell Automation programming tools for programmable logic controllers
- Control networks such as DeviceNet and programmable logic controllers such as ControlLogix® processors

The components of FactoryTalk AssetCentre

There are four primary components of a FactoryTalk AssetCentre system:

- **FactoryTalk AssetCentre server**, which controls the rest of the system and governs its operations. The server requires Microsoft SQL Server to function (see Server computer requirements on page 13). The SQL Server is typically on the same computer as the FactoryTalk AssetCentre server. The instructions in this manual are written for that case, although the SQL Server could be installed on a different computer.

- **FactoryTalk AssetCentre agents**, which are programs that perform certain scheduled operations, such as Disaster Recovery and searches. Agents run independently of the server and independently from each other—users schedule operations and the agents perform them at the scheduled time. By spreading the processing load over multiple computers, FactoryTalk AssetCentre agents speed up operations. When a server needs a scheduled operation to begin, it tries to locate an available computer running the appropriate agent to perform that task. When it locates an agent to perform the task, it assigns the task to that agent. When the agent has completed the task, the agent reports back to the server that the task is done.

  Agents can be installed on any computer that:
  
  - Is capable of running the agent software (see Agent computer requirements on page 15).
  - Is connected to the FactoryTalk AssetCentre server.

- **FactoryTalk AssetCentre clients**, which permit users to configure and use the server, view logged events, and perform other tasks associated with the software. The client can be installed on any computer that:

  - Is capable of running the client software (see Client computer requirements on page 14).
  - Is connected to the FactoryTalk AssetCentre server.

- **FactoryTalk AssetCentre Web Client**, which allows users to access a FactoryTalk AssetCentre client through a web interface on computers. FactoryTalk AssetCentre Web Client supports several FactoryTalk AssetCentre client functions. FactoryTalk AssetCentre Web Client can be accessed on any computer device that:

  - Is capable of running the Web Client software (See Web Client computer or device requirements on page 16).
  - Is connected to the FactoryTalk AssetCentre server.
The amount of clients, agents, and agent groups qualified within one FactoryTalk AssetCentre system

The following is the amount of clients, agents, and agent groups qualified within one FactoryTalk AssetCentre system at the same time. More clients, agents, or agent groups running will impact the system performance. The system cannot exceed 50 agents total. For example, a system could have 50 agent groups each with one agent member.

- Client: 150
- Agent: 50
- Agent groups: 50

System requirements

FactoryTalk AssetCentre works within the system requirements of all Rockwell Automation software products.

Hardware requirements

- For the optimal performance of the FactoryTalk AssetCentre system, we recommend that computers running FactoryTalk AssetCentre Server, FactoryTalk AssetCentre Client, or FactoryTalk AssetCentre Agent meet or exceed the following hardware requirements.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
<th>CPU</th>
<th>Core Processors</th>
<th>RAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator Workstation</td>
<td>FactoryTalk AssetCentre Client</td>
<td>Intel® Core™ i5 Standard Power processor</td>
<td>1</td>
<td>8 GB</td>
</tr>
<tr>
<td>Engineering Workstation</td>
<td>FactoryTalk AssetCentre Agent</td>
<td>Intel Core i5 Standard Power processor</td>
<td>2</td>
<td>8 GB</td>
</tr>
<tr>
<td>System Agent</td>
<td>FactoryTalk AssetCentre Agent</td>
<td>Intel Core i5 Standard Power processor</td>
<td>2</td>
<td>8 GB</td>
</tr>
<tr>
<td>Type</td>
<td>Description</td>
<td>CPU</td>
<td>Core Processes</td>
<td>RAM</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------</td>
<td>----------------------------------</td>
<td>----------------</td>
<td>------</td>
</tr>
<tr>
<td>Application Server</td>
<td>FactoryTalk AssetCentre Server</td>
<td>Small systems:</td>
<td>2</td>
<td>8 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Intel Core i5 Standard Power processor</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Medium to large systems:</td>
<td>4</td>
<td>16 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Intel® Xeon® quad-core family processor</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application Server</td>
<td>FactoryTalk AssetCentre Server</td>
<td>Small systems:</td>
<td>2</td>
<td>8 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Intel Xeon quad-core family processor</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Medium to large systems:</td>
<td>4</td>
<td>16 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Intel Xeon quad-core family processor</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- For the optimal performance of the FactoryTalk AssetCentre system, we recommend that virtual machines running FactoryTalk AssetCentre Server, FactoryTalk AssetCentre Client, or FactoryTalk AssetCentre Agent meet or exceed the following hardware requirements.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
<th>CPU</th>
<th>Core Processes</th>
<th>RAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator Workstation</td>
<td>FactoryTalk AssetCentre Client</td>
<td>Intel Xeon quad-core family processor</td>
<td>1</td>
<td>8 GB</td>
</tr>
<tr>
<td>Engineering Workstation</td>
<td>FactoryTalk AssetCentre Client</td>
<td>Intel Xeon quad-core family processor</td>
<td>2</td>
<td>8 GB</td>
</tr>
<tr>
<td>System Agent</td>
<td>FactoryTalk AssetCentre Agent</td>
<td>Intel Xeon quad-core family processor</td>
<td>2</td>
<td>8 GB</td>
</tr>
<tr>
<td>Application Server</td>
<td>FactoryTalk AssetCentre Server</td>
<td>Small systems:</td>
<td>2</td>
<td>8 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Intel Xeon quad-core family processor</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Medium to large systems:</td>
<td>4</td>
<td>16 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Intel Xeon quad-core family processor</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- For display resolution, 1024x768 or higher resolution is required.

**System size**

FactoryTalk AssetCentre is tested based on these system sizes.

<table>
<thead>
<tr>
<th>Types</th>
<th>Components</th>
<th>System architecture</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small systems</td>
<td>Server</td>
<td>AssetCentre Server, Microsoft SQL Server, and FactoryTalk Directory Server are co-located.</td>
</tr>
<tr>
<td></td>
<td>Agent</td>
<td>1-5</td>
</tr>
<tr>
<td></td>
<td>Client</td>
<td>10</td>
</tr>
<tr>
<td>Medium systems</td>
<td>Server</td>
<td>AssetCentre Server and Microsoft SQL Server are co-located. FactoryTalk Directory Server is on a separate computer.</td>
</tr>
<tr>
<td></td>
<td>Agent</td>
<td>6-25</td>
</tr>
<tr>
<td></td>
<td>Client</td>
<td>60</td>
</tr>
<tr>
<td>Large systems</td>
<td>Server</td>
<td>AssetCentre Server, Microsoft SQL Server, and FactoryTalk Directory Server are hosted on separate computers.</td>
</tr>
<tr>
<td></td>
<td>Agent</td>
<td>26-50</td>
</tr>
<tr>
<td></td>
<td>Client</td>
<td>100-150</td>
</tr>
</tbody>
</table>

**Product compatibility**

FactoryTalk AssetCentre version 12.00.00 is compatible with the following Rockwell Automation products. For the latest information regarding software platform support, refer to the Rockwell Automation Product Compatibility and Download Center.
FactoryTalk AssetCentre Client

- To edit the file and data settings for a compare operation, you must have associated software installed on the client computer. To perform archive to archive version compare, you must install the programming software on the client computer.

<table>
<thead>
<tr>
<th>Asset</th>
<th>Compatible Software</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLC-5</td>
<td>RSLogix 5</td>
<td>10.00 or later</td>
</tr>
<tr>
<td>SLC 500, MicroLogix</td>
<td>RSLogix 500</td>
<td>12.00 or later</td>
</tr>
<tr>
<td>ControlLogix, CompactLogix</td>
<td>RSLogix 5000, Studio 5000 Logix Designer</td>
<td>16 or later</td>
</tr>
<tr>
<td></td>
<td>RSLogix 5000 Compare Utility or Logix Designer Compare Tool</td>
<td>9.01 or later</td>
</tr>
<tr>
<td>FactoryTalk View Site Edition</td>
<td>FactoryTalk View Studio Enterprise</td>
<td>13.00 or later</td>
</tr>
<tr>
<td>Rockwell Automation drives</td>
<td>DriveExecutive™ Lite</td>
<td>5.02 or later</td>
</tr>
</tbody>
</table>

For more information about the specific drives that FactoryTalk AssetCentre is compatible with, see Knowledgebase Document ID: QA47141 - FactoryTalk AssetCentre RA Motor Control or PowerFlex Drive Device Support.

- FactoryTalk View ME Transfer Utility version 13.00 or later if your system includes PanelView Plus and MobileView operator interfaces
- STEP7 version 5.6 sp1 or later if your system includes Siemens S7 project.

FactoryTalk AssetCentre Agent

- For Disaster Recovery functions, the programming software for your devices MUST be installed on the agent computer.

<table>
<thead>
<tr>
<th>Asset</th>
<th>Compatible Software</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLC-5</td>
<td>RSLogix 5</td>
<td>10.00 or later</td>
</tr>
<tr>
<td>SLC 500, MicroLogix</td>
<td>RSLogix 500</td>
<td>12.00 or later</td>
</tr>
<tr>
<td>ControlLogix, CompactLogix</td>
<td>Studio 5000 Logix Designer</td>
<td>21.00 or later</td>
</tr>
<tr>
<td></td>
<td>RSLogix 5000</td>
<td>16.00 or later</td>
</tr>
<tr>
<td></td>
<td>RSLogix 5000 Compare Utility or Logix Designer Compare Tool</td>
<td>9.01 or later</td>
</tr>
<tr>
<td>PanelView Plus, MobileView</td>
<td>FactoryTalk View ME Transfer Utility</td>
<td>13.00 or later</td>
</tr>
<tr>
<td></td>
<td>FactoryTalk Linx (formerly known as RSLinx Enterprise)</td>
<td>6.31 or later</td>
</tr>
<tr>
<td>FactoryTalk View Site Edition</td>
<td>FactoryTalk View Studio Enterprise</td>
<td>13.00 or later</td>
</tr>
<tr>
<td>Rockwell Automation drives</td>
<td>DriveExecutive™ Lite</td>
<td>5.02 or later</td>
</tr>
<tr>
<td>PowerFlex Drive</td>
<td>UDC</td>
<td>15.02 or later</td>
</tr>
</tbody>
</table>

Operating systems

FactoryTalk AssetCentre is tested and supported on the operating systems installed from original Microsoft media only. FactoryTalk AssetCentre runs on 64-bit versions of the following operating systems.
IMPORTANT • Turn off the Windows updates on production computers. Installing Microsoft Service Pack release or Windows operating system updates may affect the operation of Rockwell Automation software installed on the computer. To avoid this problem, see Knowledgebase Document ID: QA2151 - Microsoft Patch Qualifications.
• Before you install FactoryTalk AssetCentre on the computer running Windows Server 2012 R2, it is required that you install the following Windows update: Windows Server 2012 R2 update: April 2014.

FactoryTalk AssetCentre Server
This version of FactoryTalk AssetCentre Server was tested on these 64-bit operating systems:

• Windows Server® 2022
• Windows Server 2019
• Windows Server 2016
• Windows Server 2012
• Windows Server 2012 R2

FactoryTalk AssetCentre Client, Agent, and Web Client
This version of FactoryTalk AssetCentre Client and Agent were tested on these 64-bit operating systems:

• Windows Server 2022
• Windows Server 2019
• Windows Server 2016
• Windows Server 2012
• Windows Server 2012 R2
• Windows® 11
• Windows 10 IoT Enterprise 2021 Long-Term Servicing Channel (LTSC)
• Windows 10 IoT Enterprise 2019 Long-Term Servicing Channel (LTSC)
• Windows 10 (v2004, v20H2, v21H1, and v21H2)

FactoryTalk AssetCentre adopts .NET 4.8 which is only supported on Windows 10 v1803 and later.

Software requirements

SQL Server databases
The following are SQL Servers supported by FactoryTalk AssetCentre.

• Microsoft SQL Server 2019

FactoryTalk AssetCentre Client
The following are minimum software requirements for FactoryTalk AssetCentre Client.

• (optional) Editing software for Siemens S7 processors, such as SIMATIC Manager
  It is only required when using Disaster Recovery for Siemens S7 (S7-300/400 with STEP7 software).
**FactoryTalk AssetCentre Agent**

The following are minimum software requirements for FactoryTalk AssetCentre Agent.

- (optional) SIMATIC NET if you want to connect to Siemens S7 processors via MPI (Multi Point Interface) or PROFIBUS protocol
  
  It is only required when using Disaster Recovery for Siemens S7 (S7-300/400 with STEP7 software).

**FactoryTalk AssetCentre Web Client**

The following are minimum software requirements for FactoryTalk AssetCentre Web Client.

- Edge version 104
- Chrome™ browser version 104
- Mozilla® Firefox® version 101

**Network requirements**

Your Microsoft Windows network must use the TCP/IP protocol.

If you use a firewall, you must configure the firewall to permit traffic on the following ports.

<table>
<thead>
<tr>
<th>Port type and name</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP port 25</td>
<td>Standard SMTP email port</td>
</tr>
<tr>
<td>TCP port 80</td>
<td>Standard WWW port</td>
</tr>
<tr>
<td>TCP port 135</td>
<td>RPC/COM endpoint mapper</td>
</tr>
<tr>
<td></td>
<td>DCOM uses TCP Port 135 to establish communication and randomly assign ports from 1000 through 65535.</td>
</tr>
<tr>
<td>TCP port 445</td>
<td>File and printer sharing</td>
</tr>
<tr>
<td>TCP port 1433</td>
<td>Communications to SQL Server</td>
</tr>
<tr>
<td>TCP port 2222</td>
<td>Source port for connections</td>
</tr>
<tr>
<td>TCP port 4241</td>
<td>FactoryTalk Live Data Message for FactoryTalk Linx (RSLinxNG.exe)</td>
</tr>
<tr>
<td>TCP port 5241</td>
<td>FactoryTalk Application Services</td>
</tr>
<tr>
<td>TCP ports 7002 - 7004</td>
<td>FactoryTalk AssetCentre</td>
</tr>
<tr>
<td>UDP port 137</td>
<td>File and printer sharing</td>
</tr>
<tr>
<td>UDP port 138</td>
<td>File and printer sharing</td>
</tr>
<tr>
<td>UDP port 1434</td>
<td>Browsing for SQL Servers</td>
</tr>
<tr>
<td>UDP port 21060</td>
<td>Rockwell Automation Trace Diagnostics</td>
</tr>
<tr>
<td>UDP port 21061</td>
<td>Rockwell Automation Trace Diagnostics</td>
</tr>
<tr>
<td>TCP/UDP 44818</td>
<td>Ethernet/IP, messaging, data transfer, or peer messaging</td>
</tr>
</tbody>
</table>

Some of these ports may vary on your network. Work with your network administrators to determine the correct port numbers to open.

**IMPORTANT** TCP port 445 can be turned off in the computers with FactoryTalk AssetCentre system or its components. If using Disaster Recovery for Remote Computer, the remote computer with the shared folder must have TCP port 445 turned on for file sharing.
You may need to open ports for other Rockwell Automation products as well. See Knowledgebase Document ID: BF7490 - TCP/UDP Ports Used by Rockwell Automation Products.

**About the installation process**

FactoryTalk AssetCentre supports two installation methods:

- Setup wizard installation
- Unattended or silent installation

The Setup wizard installs the software through the installation interface step by step. If you choose the standard Setup wizard to install FactoryTalk AssetCentre software, Chapter 2 through Chapter 5 guides you through the following tasks:

1. Install the prerequisite software for the FactoryTalk AssetCentre server.
2. Install the FactoryTalk AssetCentre server.
3. Install FactoryTalk AssetCentre agents.
4. Install FactoryTalk AssetCentre clients.

The unattended or silent installation uses command lines to specify installation properties so that the software is installed without user intervention. Unattended or silent installation doesn't omit any installation components against the standard method. It allows you to specify all installation properties before the installation starts, and then installs the software automatically. To install FactoryTalk AssetCentre software with silent or unattended installation, see Chapter 8 for detailed instructions.
Install the FactoryTalk AssetCentre Server software

This chapter describes:

- Before you install the FactoryTalk AssetCentre Server software on page 19
- Steps to install the FactoryTalk AssetCentre Server software on page 25

Before you install the FactoryTalk AssetCentre Server

The following tasks are required before installing FactoryTalk AssetCentre Server.

- Ensure that the user performing installation has administrative rights in Windows.
- Ensure that a Microsoft SQL Server is available, and it is already installed on the same computer as the intended FactoryTalk AssetCentre Server, or on a separate Microsoft Windows server.
- Ensure that the Windows account of the user performing the installation, or a Windows group of which the user performing the installation is a member, is assigned the Microsoft SQL Server System Administrator role before attempting the installation.
- If you will configure the FactoryTalk AssetCentre Server to use a remote SQL database, ensure that a standalone managed service account or a group managed service account has been created in your Windows Active Directory.

Ensure that the current Windows user has administrative rights

As part of the installation process, FactoryTalk AssetCentre creates program folders and modifies entries, which requires administrative rights in Windows. For example, the Windows domain Administrator account has these rights and will be able to successfully install the software.

Install Microsoft SQL Server

FactoryTalk AssetCentre uses a Microsoft SQL Server database to store project files and user data. You may install SQL Server on the FactoryTalk AssetCentre server computer or on another computer across a network. Microsoft SQL Server is not included in FactoryTalk AssetCentre installation package. We recommend you to acquire Microsoft SQL Server with its latest Service Pack separately.

Tip: Before you install Microsoft SQL Server, you need to turn off Windows Firewall from Windows Control Panel.
If a supported edition of SQL Server is installed, you can skip these steps, however, you may need to reconfigure the SQL Server.

**To install Microsoft SQL Server**

1. Log on to the server computer as an administrator or as a user with administrative rights.
   
   Tip: It is possible to install the SQL Server on a different computer from the one on which you install the FactoryTalk AssetCentre Server software as long as they are on the network.

2. Start the SQL Server installation from the SQL Server media.

3. Follow the on-screen instructions for installation until you get to the **Feature Selection** screen.

4. On the **Feature Selection** screen, choose the SQL Server features that you want to install. If you like, or if your business requires you to do so, you may install the complete SQL Server installation.

   If you want to install only those features necessary to run the FactoryTalk AssetCentre server:
   
   a. On the **Feature Selection** screen, make sure the following features are selected:
      
      - Database Engine Services
      - Full-Text and Semantic Extractions for Search
      - Client Tools Connectivity (not applicable for Microsoft SQL Server 2022 or later)
      - Client Tools Backwards Compatibility (not applicable for Microsoft SQL Server 2022 or later)
      - Management Tools - Basic (not applicable for Microsoft SQL Server 2016 or later)
   
   b. Click **Next**.

5. Follow the on-screen instructions for installation until you get to the **Server Configuration** screen.

6. In the **Server Configuration** screen, keep the default settings for the **Services Accounts** tab.

7. In the **Server Configuration** screen, click the **Collation** tab.

8. Under **Database Engine**, make sure that **SQL_Latin1_General_CP1_CI_AS** is selected.

   If it isn’t, click **Customize**, and then, in the **Customize the SQL Server Version Database Engine Collation** dialog box (where version is your SQL Server version), select **SQL collation, used for backwards compatibility and SQL_Latin1_General_CP1_CI_AS**.

   **IMPORTANT** The collation settings must be case-insensitive! If the settings are case-sensitive, the FactoryTalk AssetCentre database installation will fail.

9. In the **Database Engine Configuration** window, click the **Server Configuration** tab.

10. Under **Authentication Mode**, select **Windows authentication mode**.

    If you want to access the database with SQL Server Authentication in the future, select **Mixed Mode (SQL Server authentication and Windows authentication)**. If you use a SQL user account to connect the database, you have to pay attention to the disadvantages of SQL Server Authentication.

    **WARNING:**
    
    - A number of failed sign-in attempts from attackers will cause a user account to be locked.
    - The encrypted SQL Server Authentication login password must be passed over the network at the time of the connection. Some applications that connect automatically will store the password at the client. These are additional attack points.
    - Windows offers additional password policies that are not available for SQL Server logins.
When you select **Mixed Mode**, fields open for entering the password for the sa (SQL Server system administrator) account password. Do not forget the password. You may need this password when you install the FactoryTalk AssetCentre server.

**IMPORTANT** Do not leave the password blank. Doing so leaves your SQL Server and your computer open to attack.

11. Follow the on-screen instructions to complete the installation.

After you install a Microsoft SQL Server, you must install an appropriate service pack, which is necessary for the software to run properly and protects your SQL Server from certain types of attacks.

Tip: We recommend that you install Microsoft SQL Servers with their latest Service Pack.

**Minimum Microsoft SQL Server permissions**

The permissions discussed here are set automatically during the FactoryTalk AssetCentre Database installation. The information is provided for reference for the SQL administrator.

The Microsoft service accounts (virtual service account, standalone managed service account, and group managed service account) user's default database value can be **master** or **AssetCentre**. By default, the database value is set to **AssetCentre**. The Microsoft service accounts (virtual service account, standalone managed service account, and group managed service account) user needs to belong to the following AssetCentre database roles:

- db_dataexecute
- db_datareader
- db_datawriter
- public

The db_dataexecute database role was added to the FactoryTalk AssetCentre database during the FactoryTalk AssetCentre server installation. All of the user stored procedures and user functions in the FactoryTalk AssetCentre database need to have the **Execute** permission granted to the db_dataexecute database role.

**Configure the certificate for encrypted connection to the database**

SQL Server can use Transport Layer Security (TLS) to encrypt data that is transmitted across a network between an instance of SQL Server and an application. TLS can be used for server validation when a client connection requests encryption.

We recommend using certificates signed by a certificate authority (CA). Encryption with a self-signed certificate is possible, but a self-signed certificate offers only limited protection.

For encrypted connection to the database with a CA issued certificate, besides configuring a certificate on the SQL Server computer, you also need to:

- Configure a certificate on the SQL Server computer
- Configure a certificate on the FTAC server computer
For encrypted connection to the database with a self-signed certificate, you need to create the certificate before installing.

**IMPORTANT** There will be an exception during the FactoryTalk AssetCentre installation if you don't configure the SQL Server certificate.

### Configure a certificate on the SQL Server computer

To establish encrypted connections to the database, first install the certificate on the SQL Server computer.

**To configure a certificate on the SQL Server computer**

1. Add the snap-in.
   a. On the **Start** menu, select **Run**, enter **MMC** in the **Open** box, and then select **OK**.
   b. In the Microsoft Management Console, select **File > Add/Remove Snap-in**.
   c. In the **Add or Remove Snap-ins** dialog box, select **Certificates**, and then select **Add**.
   d. In the **Certificates snap-in** dialog box, select **Computer account**, and then select **Next**.
   e. In the **Select Computer** dialog box, keep the default **Local computer** selection, and then select **Finish**.
   f. In the **Add or Remove Snap-ins** dialog box, select **OK**.

2. Import the certificate.
   a. In the Microsoft Management Console, expand **Certificates > Personal**, right-click **Certificates**, and then select **All Tasks > Import**.
   b. In the Certificate Import Wizard, specify the certificate file's full path, and then select **Next**.
   c. Enter the password, and then select **Next**.
   d. Specify the certificate store as **Personal**, and then select **Next**.
   e. Select **Finish**.

3. Add the SQL Server service account permission.
   a. In the Microsoft Management Console, right-click the imported certificate, and then select **All Tasks > Manage Private Keys**.
   b. In the **Security** dialog box, add read permission for the user account used by the SQL Server service account. Note that the location should be your local computer name.

   **Tip:** To find the SQL Server service account:
   1. Open Windows **Services**.
   2. Double-click **SQL Server (InstanceName)**.
   3. Select the **Log On** tab, and then find the SQL Server service account in the **This account** box.

4. Add the certificate to the SQL Server instance.
a. Open SQL Server Configuration Manager.

b. Expand SQL Server Network Configuration, right-click Protocols for InstanceName, and then select Properties.

c. In the Protocols for InstanceName Properties dialog box, select the Certificate tab, and then select the certificate from the Certificate list.

d. Select OK.

5. Restart SQL Server.

   a. In SQL Server Configuration Manager, select SQL Server Services.

   b. Right-click SQL Server (InstanceName), and then select Restart.

**Configure a certificate on the FactoryTalk AssetCentre server computer**

To establish encrypted connections to the database, after assigning a certificate to the SQL Server computer, set up the FactoryTalk AssetCentre server to trust the certificate's root authority.

**To configure a certificate on the FactoryTalk AssetCentre server computer**

1. Add the snap-in.

   a. On the Start menu, select Run, enter MMC in the Open box, and then select OK.

   b. In the Microsoft Management Console, select File > Add/Remove Snap-in.

   c. In the Add or Remove Snap-ins dialog box, select Certificates, and then select Add.

   d. In the Certificates snap-in dialog box, select Computer account, and then select Next.

   e. In the Select Computer dialog box, keep the default Local computer selection, and then select Finish.

   f. In the Add or Remove Snap-ins dialog box, select OK.

2. Import the certificate.

   a. In the Microsoft Management Console, expand Certificates > Trusted Root Certification Authorities, right-click Certificates, and then select All Tasks > Import.

   b. In the Certificate Import Wizard, specify the certificate file's full path, and then select Next.

   c. Enter the password, and then select Next.

   d. Specify the certificate store as Trusted Root Certification Authorities, and then select Next.

   e. Select Finish.

**Create a self-signed TLS certificate on the SQL Server computer**

Follow these steps to create a self-signed TLS certificate on the SQL Server computer. The certificate must be issued for server authentication. The certificate should contain the computer name (fully qualified domain name) of SQL Server.
To create a self-signed TLS certificate on the SQL Server computer

1. Open Internet Information Services (IIS) Manager on the SQL Server computer, and then double-click Server Certificates.
2. Under Actions, click Create Self-Signed Certificate.
3. In the Create Self-Signed Certificate dialog box:
   • Specify a name for the certificate.
   • Select Web Hosting as the certificate store.
4. Click OK.

Create and install a standalone managed service account or group managed service account

FactoryTalk AssetCentre version 11.00.00 and later support standalone managed service accounts (sMSA) and group managed service accounts (gMSA) that provide automatic password management, simplified service principal name (SPN) management, and the ability to delegate the management to other administrators.

Prerequisites

Make sure that:

• Your operating system is Windows Server 2012 R2 (patched with KB2998082) or later.
• Your SQL server is SQL Server 2014 or later.
• You have Active Directory module for Windows PowerShell installed on your computer.

To create and install an sMSA

1. On the domain controller computer, open the Windows PowerShell window.
2. To verify that the Key Distribution Service (KDS) Root Key for your domain controller is installed on your computer, enter Test-KdsRootKey -KeyId (Get-KdsRootKey).KeyId.
   If the returned value is True, it means that KDS Root Key is already installed.
   If the returned value is False, it means that there is no valid KDS Root Key. To add a KDS Root Key, enter Add-KdsRootKey -EffectiveImmediately.
   Note: It may take up to 10 hours to implement the function of the KDS Root Key.
3. To create an sMSA, enter New-ADServiceAccount -Name <msa01> -Enabled:$true -Description "Manage Service Account for FTAC" -DisplayName <msa01> -RestrictToSingleComputer
   Note:
   • The "<>" means it is a variable. You can customize the name as needed.
   • Quotes are required for the name with space. For example, "msa 01".
   • Please pay attention to the space between the syntax.
4. On the FactoryTalk AssetCentre server computer, open the Windows PowerShell window, and then enter Install-WindowsFeature RSAT-AD-PowerShell -ComputerName <winsql-01> to install the Active Directory PowerShell module.
5. To install the sMSA, enter `Install-ADServiceAccount -Identity <msa01>.

6. To test the sMSA, enter `Test-ADServiceAccount -Identity <msa01>.

An sMSA is only allowed for using on one computer. If you want to use it on another computer, enter `UnInstall-ADServiceAccount -Identity <msa01>`, and then install it on the computer as needed.

**To create and install a gMSA**

1. On the domain controller computer, open the **Windows PowerShell** window.

2. To verify that the Key Distribution Service (KDS) Root Key for your domain controller is installed on your computer, enter `Test-KdsRootKey -KeyId (Get-KdsRootKey).KeyId`.

   If the returned value is `True`, it means that KDS Root Key is already installed.

   If the returned value is `False`, it means that there is no valid KDS Root Key. To add a KDS Root Key, enter `Add-KdsRootKey -EffectiveImmediately`.

   Note: It may take up to 10 hours to implement the function of the KDS Root Key.


   Note:
   - The "<>" means it is a variable. You can customize the name as needed.
   - Quotes are required for the name with space. For example, "gmsa 01".

4. To add computer objects to the AD Security group, enter `Add-ADGroupMember -Identity <gsg_gmsa01> -Members <winsql-0$, <winsql-01$>`.

   Note: When adding the computer objects, it is required to add "$" after the computer account name and restart the computer.

5. To create a gMSA, enter `New-ADServiceAccount -Name <gmsa01> -PrincipalsAllowedToRetrieveManagedPassword <gsg_gmsa01> -Enabled:$true -DNSHostName ServerD.astest.com`.

6. On the FactoryTalk AssetCentre server computer, enter `Test-ADServiceAccount -Identity <gmsa01>` to test the gMSA. For some operating system, you need to restart the computer before entering the code.

**Steps to install the FactoryTalk AssetCentre Server**

The Setup wizard installation process includes the following steps:

- **Step 1:** Launch the Setup wizard and select what to install on page 26
- **Step 2:** Configure the AssetCentre server on page 27
- **Step 3:** Read and accept license agreements on page 28
- **Step 4:** Configure TLS setting on page 28
- **Step 5:** Start the installation on page 29
- **Step 6:** Finish the installation on page 29
Step 1: Launch the Setup wizard and select what to install

Before starting the installation of FactoryTalk AssetCentre server, you should ensure:

- Select **Windows Authentication**, when you install Microsoft SQL Server.

  **IMPORTANT** - If you select **Mixed Mode** when installing Microsoft SQL Server, you can use SQL Server Authentication to access remote database.
  - When using SQL Server Authentication, you must use silent or unattended setup to install FactoryTalk AssetCentre version 11.00.00 or later.

- When SQL Server and FactoryTalk AssetCentre server are co-located, the system will automatically use a Windows virtual service account.
- A standalone managed service account (sMSA) or group managed service account (gMSA) is required when the SQL Server is remote from the FactoryTalk AssetCentre server.
- Windows local user account, Windows Active Directory (AD) user account or a Windows AD group where your user account is a member has been assigned SQL Server system administrator role.

When installing FactoryTalk AssetCentre server, you can follow the steps as below:

1. Log on to your server computer as an administrator, or as a user with administrative privileges.
2. If necessary, close all open Windows programs, and then place the FactoryTalk AssetCentre Installation DVD in the computer's DVD drive.
   
   Tip: You can also select FactoryTalk AssetCentre Server to download the software from the Rockwell Automation Product Compatibility and Download Center.
3. Run `D:\setup.exe`, where `D:` is the drive containing the DVD.
4. Select **AssetCentre Server**.
   
   Tip: To install **AssetCentre Server**, **AssetCentre Client**, and **AssetCentre Agent** at the same time, select **AssetCentre Custom Installation**. Custom installation allows you to install more than one or all of the installation components.
5. Select **Customize**.
6. On the Customize page, the required software and components for FactoryTalk AssetCentre Server installation include:

   - **FactoryTalk Services Platform v6.31.00**

     - **FactoryTalk Directory Server Services**

     The FactoryTalk Directory Server Services include the FactoryTalk Reverse Proxy, the FactoryTalk Web Authentication Server, and the FactoryTalk Web Event Server. When selecting **AssetCentre Server** during installation, the FactoryTalk Directory Server Services will be selected by default. You can enable the FactoryTalk Directory Server Services as needed.

     - **FactoryTalk Reverse Proxy**

     The computer acting as the FactoryTalk AssetCentre server must also host FactoryTalk Reverse Proxy. You can install the FactoryTalk Reverse Proxy without installing the FactoryTalk Web Authentication Server and the FactoryTalk Web Event Server; the converse is not allowed.
• FactoryTalk Web Authentication Server

If your system requires the FactoryTalk Web Authentication Server, for example, to enable the use of the FactoryTalk AssetCentre version 12.00 Web Client, the computer acting as the FactoryTalk Directory server must also host the FactoryTalk Web Authentication Server. When selecting FactoryTalk Web Authentication Server during installation, the FactoryTalk Reverse Proxy will also be installed. There is no option to not install the FactoryTalk Reverse Proxy when installing the FactoryTalk Web Authentication Server.

• FactoryTalk Web Event Server

The FactoryTalk Web Event Server provides a FactoryTalk eventing subsystem based on Socket.IO rather than DCOM. There is no option to not install the FactoryTalk Reverse Proxy when installing the FactoryTalk Web Event Server.

• FactoryTalk Linx v6.31.00
• FactoryTalk Alarms and Events v6.31.00
• FactoryTalk Activation Manager v5.00.11
• AssetCentre Server v12.00.00

The recommended software and components for FactoryTalk AssetCentre Server installation include:

• Register EDS Files

   Register EDS Files will be installed to support devices browse.

• FactoryTalk Updater Agent v4.00.00

   To install the FactoryTalk Updater utility, expand Tools and then select FactoryTalk Updater Agent v4.00.00. It assists management of installed Rockwell Automation software by announcing new versions and patch roll-ups. Registering for updates is not required to receive announcements from the FactoryTalk Updater.

The optional software and components include:

• FactoryTalk System Status Portal
• HistorianME Security Web Service

7. Select the location for the software. The default location is C:\.
8. Select Next.

Step 2: Configure the FactoryTalk AssetCentre Server

You can configure the FactoryTalk AssetCentre Server with a local or a remote database.

To configure the FactoryTalk AssetCentre Server

1. In the Database Server box, enter the name of the database server.
   
   • For the local database server

   If you selected the default instance during the Microsoft SQL Server installation, keep the default name of the database server as (local).
If you customized the instance during the Microsoft SQL Server installation, you need to enter the database server name. For example, WIN-2B92QFPB9C0\SQLSERVERTEST. SQLSERVERTEST is the customized instance name

- For the remote database server

Enter the name of a remote database server, or in the Location list, choose the location of the remote database server you ever used.

**IMPORTANT**
The default port used for SQL Server communication is 1433. If you want to change the SQL Server port, you must add the port number after the the SQL Server name during installation. For example, mySQLServer,1526. The comma (,) is required.
You must ensure that the port is not in use by any other application, service, or process in your system.

2. Select **Next**.
3. On the Configure AssetCentre Server database page, select **Next**.

When the SQL Server is remote from the FactoryTalk AssetCentre Server, do the following:

a. On the Configure AssetCentre Server database page, select **Add**.

b. In the Select Service Account dialog box, select **Advanced**, and then select **Find Now**.

c. In the Search results box, select the sMSA or gMSA created, and then select **OK**.

d. On the Configure AssetCentre Server database page, select **Next**.

Note: If you turn on TLS for secure communication within the FactoryTalk AssetCentre system and use a self-signed certificate, you need to enter the full computer name of the Database Server.

**Step 3: Read and accept license agreements**

End-user license agreements (EULA) spell out your rights and responsibilities. Depending on the components being installed, there may be more than one license agreement on this page. The individual license agreements are listed above the text box.

Some software products may be delivered or made available only after you agree to the terms and conditions of each of the license agreements.

1. On the End User License Agreements page, select each agreement and read the agreement carefully.
2. When all license agreements have been read, select **Accept All**.

**Step 4: Configure TLS setting**

We recommend that you turn on HTTPS to secure the network. To use HTTPS, you must configure TLS certificate after installing FactoryTalk AssetCentre.
To configure TLS setting

1. On the Configure AssetCentre Server page, make sure the Secure communication with TLS check box is selected.

   **WARNING:** If you don't want use HTTPS, clear the Secure communication with TLS check box. The potential risks of turning off HTTPS are as below:
   - The data is transmitted without encryption across a network, which will cause leakage of information, if other solutions, such as IPSEC, are not used.
   - The system may be vulnerable to a Remote Code Execution (RCE) attack.

2. Select Install.

Step 5: Start the installation

After accepting the license agreements, the Setup wizard automatically installs all the Rockwell Software applications selected previously. No further user input is required.

Step 6: Finish the installation

After the installation completes, you need to activate the software for its full feature capabilities. You can activate the software now or later.

- To activate the installed software, select Activate your software, and then select Next.
  The Software Activation dialog box opens.
  a. In the Serial number box, enter the serial number.
  b. In the Product key box, enter the product key.
  c. Select the earliest version you will use.
  d. Select Activate locally or Activate using a dongle.
  e. Click Continue.

  You will be prompted to restart the computer after the activation.

- To finish the installation without activation, select Skip activation, and then select Next.
  - To view the installation details, select Installation Summary.
  - To receive the latest product updates and patch notification, select Register for updates.
  - To install the latest version of Adobe® Acrobat® Reader®, select Download it free and follow the on-screen instructions.

  Restart the computer to complete the installation.

After installation of FactoryTalk AssetCentre Server software

HTTPS configuration
If you have HTTPS turned on during the installation of FactoryTalk AssetCentre, you must [Configure the TLS protocol for FactoryTalk AssetCentre](#) on page 83. We recommend that you use a TLS certificate signed by a certificate authority (CA) to secure the communication.

**Install the latest FactoryTalk AssetCentre patches**

For more information about the latest FactoryTalk AssetCentre patches, see Knowledgebase Document ID: [QA15600 - FactoryTalk AssetCentre Patch Roll-up for 3.0 and later](#).
Install FactoryTalk AssetCentre Agent software

This chapter describes:

- Before you install the FactoryTalk AssetCentre Agent software on page 31
- Steps to install the FactoryTalk AssetCentre Agent software on page 32
- Configure for security-enabled RSLogix family software on page 35
- Check log of error messages for FactoryTalk AssetCentre Agent on page 36

Before you install the FactoryTalk AssetCentre Agent software

Agents are programs that communicate with the FactoryTalk AssetCentre Server and perform scheduled tasks on behalf of the FactoryTalk AssetCentre Server. Agents allow work to be distributed and shared among multiple computers to spread processing load and speed up operations. When a server needs an agent to perform a task, it locates the computer running the operation and assigns the task to that agent. The agent then reports the task's completion to the server. The Search feature, as well as purchased capabilities, such as Disaster Recovery capabilities, require the use of agents to perform scheduled operations.

Where to install the FactoryTalk AssetCentre Agent software

We recommend that you install FactoryTalk AssetCentre Agent software on the workstation:

- Being capable of running the Agent software (see Agent computer requirements on page 15).
- In the same network as the FactoryTalk AssetCentre Server.
- Running the FactoryTalk AssetCentre Server.

If scheduled operations are taking longer than desired to complete, you may need install more Disaster Recovery agents. To estimate the number of necessary FactoryTalk AssetCentre agents in your system, see Knowledgebase Document ID: IN29429 - Determining the Necessary Number of FactoryTalk AssetCentre Agents.

You can use the Agent Controller Launch Control Panel to start the agent controller application automatically following a restart of the computer.

The agent computer MUST have the appropriate RSLogix family software for your devices to perform Disaster Recovery functions.

Enable .NET Framework 3.5 features

You need to manually install .NET Framework 3.5 SP1 before installing the FactoryTalk AssetCentre agent, if you plan to use Logix Designer Compare Tool on one of the following operating systems:
• Windows Server 2022
• Windows Server 2019
• Windows Server 2016
• Windows Server 2012 R2

Tip: To enable the .NET Framework features, you need to log on to the computer as an administrator or a user with administrative privileges.

To install .NET Framework 3.5 SP1

• If you have an Internet connection, install .NET Framework 3.5 SP1 via Control Panel. Learn how at http://msdn.microsoft.com/en-us/library/hh506443.aspx.

• If you do not have an Internet connection, install .NET Framework 3.5 SP1 with DISM (Deployment Image Servicing and Management) command-line tool. You need the original Windows installation DVD and administrative rights in the operating system. Perform the following steps.

1. Insert the Windows installation DVD.

2. Open a Command Prompt window with administrative credentials (that is, click Search in the charms bar, type CMD in the search box; in the searching results, right-click the Command Prompt icon, and choose Run as administrator.)

3. In the Command Prompt window, type the following command, and then press Enter:

   DISM /Online /Enable-Feature /FeatureName:NetFx3 /All /LimitAccess /Source:E:\sources\sxs

   Tip: In the command, the /Source: specifies the location of the files needed for the .NET Framework 3.5 SP1 installation. You need to specify this location according to the path to your Windows installation DVD. In this example, the location is E:\sources\sxs. When the installation is completed, the following message shows in the Command Prompt window: “The operation completed successfully.”

For more information on installing .NET 3.5 SP1, including troubleshooting tips, visit:

• http://support.microsoft.com/kb/2734782

Steps to install the FactoryTalk AssetCentre Agent software

The Setup wizard installation process includes the following steps:

• Step 1: Launch the Setup wizard and select what to install on page 32
• Step 2: Read and accept license agreements on page 34
• Step 3: Start the installation on page 34
• Step 4: Finish the installation on page 35

Step 1: Launch the Setup wizard and select what to install

You must have the appropriate Rockwell Automation software for your devices installed on the agent computer to run Disaster Recovery schedules.

You can install the agent using either the installation package or the FactoryTalk AssetCentre server website.
To install a FactoryTalk AssetCentre agent using the installation package

1. Log on to your server computer as an administrator, or as a user with administrative privileges.
2. If necessary, close all open Windows programs, and then place the FactoryTalk AssetCentre Installation DVD in the computer's DVD drive.
   
   Tip: You can also select FactoryTalk AssetCentre Server to download the software from the Rockwell Automation Product Compatibility and Download Center.

   Run D:\setup.exe, where D:\ is the drive containing the DVD.

3. Select AssetCentre Agent.
   
   Tip: To install AssetCentre Server, AssetCentre Client, and AssetCentre Agent at the same time, select AssetCentre Custom Installation. Custom installation allows you to install more than one or all of the installation components.

4. To install all components available in the selected software using the recommended settings, click Install now and skip to Step 2: Read and accept license agreements on page 34.

5. To select which components to install, click Customize.

6. On the Customize page, the required software and components for FactoryTalk AssetCentre Agent installation include:

   - FactoryTalk Services Platform v6.31.00
   - FactoryTalk Web Authentication Server
     
     If your system requires the FactoryTalk Web Authentication Server, for example, to enable the use of the FactoryTalk AssetCentre version 12.00.00 Web Client, the computer acting as the FactoryTalk Directory server must also host the FactoryTalk Web Authentication Server. When selecting FactoryTalk Web Authentication Server during installation, the FactoryTalk Reverse Proxy will also be installed. There is no option to not install the FactoryTalk Reverse Proxy when installing the FactoryTalk Web Authentication Server.
   - FactoryTalk Reverse Proxy
     
     The computer acting as the FactoryTalk AssetCentre server must also host FactoryTalk Reverse Proxy. You can install the FactoryTalk Reverse Proxy without installing the FactoryTalk Web Authentication Server; the converse is not allowed.
   - FactoryTalk Linx v6.31.00
   - FactoryTalk Alarms and Events v6.31.00
   - FactoryTalk Activation Manager v5.00.11
   - AssetCentre Agent v12.00.00
   - RSLinx Classic v4.30.00

   The recommended software and components for FactoryTalk AssetCentre Agent installation include:

   - Register EDS Files
     
     Register EDS Files will be installed to support devices browse.
   - Logix Designer Compare Tool v9.01.00
     
     Microsoft .NET Framework 3.5 is required for the installation of Logix Designer Compare Tool.
   - RSLinx 5 v10.00.00
   - RSLinx 500 v12.00.00
• FactoryTalk View ME Transfer Utility v13.00.00
• FactoryTalk Updater Agent v4.00.00

To install the FactoryTalk Updater utility, expand Tools and then select FactoryTalk Updater Agent v4.00.00. It assists management of installed Rockwell Automation software by announcing new versions and patch roll-ups. Registering for updates is not required to receive announcements from the FactoryTalk Updater.

The optional software and components include:

• FactoryTalk System Status Portal
• HistorianME Security Web Service
• Enable Security

When using FactoryTalk AssetCentre to work with RSLogix 5 or RSLogix 500 to do Disaster Recovery schedule and the RSLogix editors have been secured, you have to select the Enable Security check box.

• SmartGuardUSB - KernelDrivers

7. Select the location for the software. The default location is C:\.

8. Select Next.

9. In the Security options box, select the options for RSLogix 5 as needed. If you do not want to use FactoryTalk Security, clear the Enable FactoryTalk® Security check box.

   Note: For more information about the RSLogix 5 installation, refer to RSLogix 5 Getting Results Guide.

10. Click Next.

11. In the Security options box, select the options for RSLogix 500 as needed. If you do not want to use FactoryTalk Security, clear the Enable FactoryTalk® Security check box.

   Note: For more information about the RSLogix 500 installation, refer to RSLogix 500 Getting Results Guide.

12. Select Install.

**Step 2: Read and accept license agreements**

End-user license agreements (EULA) spell out your rights and responsibilities. Depending on the components being installed, there may be more than one license agreement on this page. The individual license agreements are listed above the text box.

Some software products may be delivered or made available only after you agree to the terms and conditions of each of the license agreements.

1. On the End User License Agreements page, select each agreement and read the agreement carefully.

2. When all license agreements have been read, select Accept All.

**Step 3: Start the installation**

After accepting the license agreements, the Setup wizard automatically installs all the Rockwell Software applications selected previously. No further user input is required.
Step 4: Finish the installation

Restart the computer to complete the installation.

Configure for security-enabled Rockwell Automation software

If FactoryTalk Security is enabled in your Rockwell Automation software (Studio 5000 Logix Designer, RSLogix 5000, RSLogix 500, and RSLogix 5), you must configure the Disaster Recovery agent, and FactoryTalk Security to grant the necessary permissions for Disaster Recovery operations. FactoryTalk Security is always enabled in Studio 5000 Logix Designer and RSLogix 5000.

These instructions assume that the FactoryTalk AssetCentre agent software has been installed, and that all RSLogix family software packages that will be used in the system are also installed on each agent computer.

- To configure the FactoryTalk AssetCentre agents and FactoryTalk Security in a Windows workgroup, follow instructions in If operating in a Windows workgroup on page 35.

If operating in a Windows workgroup

On each agent computer

Perform these steps on each agent computer in the system. These steps show you how to create a new Windows user account and a new FactoryTalk user account for each agent computer.

FactoryTalk AssetCentre provides a utility to facilitate the process of creating and setting security credentials necessary for secured RSLogix editors. You can configure the agent computer using the utility or manually configure the agent computer.

To configure the agent computer using the Agent Services Logon Configuration utility

1. From Windows Start menu, select All Programs > Rockwell Software > FactoryTalk AssetCentre Agent > Agent Services Logon Configuration.
2. Use the Agent Services Logon Configuration dialog box to create and set security credentials:
   - Tip: The name must follow the Windows user name policies, for example:
     - User names must be no more than 20 characters in length.
     - User names cannot contain certain characters. Invalid characters include: */\[]:;?=,+
   a. In the User Name field, enter a user name. The default user name is AssetCentre_Dr.
   b. In the Password field, enter a password for the user.
   c. In the Confirm Password field, enter the password again.
   d. When complete, click OK.

The utility creates the user as a local Windows administrator account and adds it to FactoryTalk as a Windows-linked user account. The FactoryTalk AssetCentre VerificationAgent service is logged on as the user. The utility also configures the necessary security permissions for Logix Designer application, RSLogix 5000, RSLogix 500, and RSLogix 5 software packages.
To manually configure the agent computer

1. On the agent computer, use the Computer Management utility in Microsoft Windows to create a Windows user account that can be used to authenticate with FactoryTalk Security.
2. Add the new Windows user account to the local Administrators group.
3. Configure both services to run as the new Windows user account created in step 1. To do so, open the Services utility in Microsoft Windows, find the VerificationAgent service and edit its properties to log on as the account.
4. Open the FactoryTalk Administration Console and add the new Windows user account created above as a new Windows-linked user.

On any computer in the system

Perform these steps on any computer connected to the FactoryTalk Network Directory. These steps need only be performed once and will be in effect for the entire FactoryTalk Network Directory.

1. In the FactoryTalk Administration Console, create a new user group called Local Agent Users.
2. The users created on different agent computers in the previous section (whether using the utility, or added manually) all appear in the FactoryTalk Network Directory as individual users. Add each of these new FactoryTalk users to the Local Agent Users group. This will facilitate making security settings because you will be able to set them once for the whole group, rather than for each user.
3. Grant the Local Agent Users group read access to the FactoryTalk Directory. To do so, right-click the Network node at the top of the tree, and then select Security. On the Permissions tab, select the Local Agent Users group and then expand the Common permissions group. Make sure the Read permission is set to Allow.
4. Set permissions for your RSLogix family software packages (depending on what type of processors you are using). Under System in the Explorer pane, right-click Networks and Devices and select Security. If the Local Agent Users group does not appear in the list, add it. On the Permissions tab, select the Local Agent Users group. Expand the permissions group for the appropriate software and set the following permissions to Allow:
   • For RSLogix 5 grant Offline Program File Monitoring, Save, and Upload.
   • For RSLogix 500 grant Offline Program File Monitoring, Save, and Upload.

After installation of FactoryTalk AssetCentre Agent software

HTTPS configuration
If you have HTTPS turned on during the installation of FactoryTalk AssetCentre, you must Configure the TLS protocol for FactoryTalk AssetCentre on page 83. We recommend that you use a TLS certificate signed by a certificate authority (CA) to secure the communication.

**Install the latest FactoryTalk AssetCentre patches**

For more information about the latest FactoryTalk AssetCentre patches, see Knowledgebase Document ID: QA15600 - FactoryTalk AssetCentre Patch Roll-up for 3.0 and later.
Install FactoryTalk AssetCentre Client software

This chapter describes:

- Before you install FactoryTalk AssetCentre Client software on page 39
- Steps to install FactoryTalk AssetCentre Client software on page 40

Before you install FactoryTalk AssetCentre Client software

The FactoryTalk AssetCentre Client software provides the user interface for FactoryTalk AssetCentre. It is through the client that you perform tasks such as checking files in and out, creating and running scheduled events, and viewing logs. For more information on what you can do with FactoryTalk AssetCentre client software, see the FactoryTalk AssetCentre Help after the client is installed.

Install the FactoryTalk AssetCentre Client software on all computers on which you want to use FactoryTalk AssetCentre.

The client is not required on the FactoryTalk AssetCentre server computer, but you can install it on the server if desired.

Where to install FactoryTalk AssetCentre Client software

Note: For current information on the system requirements for the FactoryTalk AssetCentre software, see FactoryTalk AssetCentre Release Notes and the Product Compatibility and Download Center.

Install the client on any computer

- From which you want to access the FactoryTalk AssetCentre Client software (to edit the representation of your assets, to view logs, to create schedules, to search the logs, and so on).
- That is capable of running the Client software (see Client computer requirements on page 14).
- That is connected to the FactoryTalk AssetCentre Server.
- From which FactoryTalk audits are desired.

Note: The Disaster Recovery capability provides the ability to schedule a comparison between master files, and processor program and data files. To edit the file and data settings for a compare operation for PLC-5, SLC 500, or MicroLogix processors, you must have RSLogix 5, or RSLogix 500 software installed on the client computer.
Steps to install FactoryTalk AssetCentre Client software

The Setup wizard installation process includes the following steps:

- Step 1: Launch the Setup wizard and select what to install on page 40
- Step 2: Read and accept license agreements on page 41
- Step 3: Start the installation on page 42
- Step 4: Finish the installation on page 42

Step 1: Launch the Setup wizard and select what to install

You can install the client using either the installation package.

To install a FactoryTalk AssetCentre Client software using the installation package

1. Log on to your server computer as an administrator, or as a user with administrative privileges.
2. If necessary, close all open Windows programs, and then place the FactoryTalk AssetCentre Installation DVD in the computer's DVD drive.
   
   Tip: You can also select FactoryTalk AssetCentre Server to download the software from the Rockwell Automation Product Compatibility and Download Center.

   Run D:\setup.exe, where D\ is the drive containing the DVD.

3. Select AssetCentre Client.
   
   Tip: To install AssetCentre Server, AssetCentre Client, and AssetCentre Agent at the same time, select AssetCentre Custom Installation. Custom installation allows you to install more than one or all of the installation components.

4. To install all components available in the selected software using the recommended settings, click Install now and skip to Step 2: Read and accept license agreements on page 41.
5. To select which components to install, click Customize.
6. On the Customize page:

   The required software and components for FactoryTalk AssetCentre Client installation include:

- FactoryTalk Services Platform v6.31.00
- FactoryTalk Web Authentication Server
  
  If your system requires the FactoryTalk Web Authentication Server, for example, to enable the use of the FactoryTalk AssetCentre version 12.00 Web Client, the computer acting as the FactoryTalk Directory server must also host the FactoryTalk Web Authentication Server. When selecting FactoryTalk Web Authentication Server during installation, the FactoryTalk Reverse Proxy will also be installed. There is no option to not install the FactoryTalk Reverse Proxy when installing the FactoryTalk Web Authentication Server.

- FactoryTalk Reverse Proxy

  The computer acting as the FactoryTalk AssetCentre server must also host FactoryTalk Reverse Proxy. You can install the FactoryTalk Reverse Proxy without installing the FactoryTalk Web Authentication Server; the converse is not allowed.

- FactoryTalk Linx v6.31.00
• FactoryTalk Alarms and Events v6.31.00
• FactoryTalk Activation Manager v5.00.11
• AssetCentre Client v12.00.00
• RSLogix Classic v4.30.00

The recommended software and components for FactoryTalk AssetCentre Client installation include:

• 3rd party editor integration
  Step 7 Version 5.6 sp1
  If the installation detects the Step7 editor file (S7tgtopx.exe) at either of the following paths, you can choose to select Step7 Version 5.6 sp1 and install the feature. If you have the Step7 editor file installed, make sure they are located at either of the following paths for the installation to detect.
  • C:\Siemens\Step7\s7bin
  • C:\Program Files\Siemens\Step7\s7bin or C:\Program Files (x86)\Siemens\Step7\s7bin
  Tip: If you have S7 processors, you may also need to install the Step7 feature. This step is not required for Disaster Recovery actions, it merely associates project files with the appropriate editor.

  You can install the Step7 feature at this point or install it after the installation. To install it after installing FactoryTalk AssetCentre Client:
  1. Run setup.exe in the installation package.
  2. Select AssetCentre Client and click Modify.
  3. Expand AssetCentre Client v12.00.00 and select Step7 Version 5.6 sp1.
  4. Click Modify.

• Register EDS Files
  Register EDS Files will be installed to support devices browse.

• FactoryTalk Updater Agent v4.00.00
  To install the FactoryTalk Updater utility, expand Tools and then select FactoryTalk Updater Agent v4.00.00. It assists management of installed Rockwell Automation software by announcing new versions and patch roll-ups. Registering for updates is not required to receive announcements from the FactoryTalk Updater.

  The optional software and components include:
  • FactoryTalk System Status Portal
  • HistorianME Security Web Service
  • Enable Security
  • SmartGuardUSB - KernelDrivers

  7. Select the location for the software. The default location is C:.
  8. Click Install.

Step 2: Read and accept license agreements

End-user license agreements (EULA) spell out your rights and responsibilities. Depending on the components being installed, there may be more than one license agreement on this page. The individual license agreements are listed above the text box.
Some software products may be delivered or made available only after you agree to the terms and conditions of each of the license agreements.

1. On the End User License Agreements page, select each agreement and read the agreement carefully.
2. When all license agreements have been read, select Accept All.

**Step 3: Start the installation**

After accepting the license agreements, the Setup wizard automatically installs all the Rockwell Software applications selected previously. No further user input is required.

**Step 4: Finish the installation**

Restart the computer to complete the installation.

**After installation of FactoryTalk AssetCentre Client software**

**HTTPS configuration**

If you have HTTPS turned on during the installation of FactoryTalk AssetCentre, you must Configure the TLS protocol for FactoryTalk AssetCentre on page 83. We recommend that you use a TLS certificate signed by a certificate authority (CA) to secure the communication.

**Install the latest FactoryTalk AssetCentre patches**

For more information about the latest FactoryTalk AssetCentre patches, see Knowledgebase Document ID: QA15600 - FactoryTalk AssetCentre Patch Roll-up for 3.0 and later.
Custom install the FactoryTalk AssetCentre software

FactoryTalk AssetCentre supports custom installation of the FactoryTalk AssetCentre software. Custom installation allows you to install more than one or all of the installation components, including AssetCentre Server, AssetCentre Client, and AssetCentre Agent.

Before starting the installation of FactoryTalk AssetCentre system, you should ensure that:

FactoryTalk AssetCentre Server

- Select Windows Authentication, when you install Microsoft SQL Server.
  
  **IMPORTANT**
  - If you select Mixed Mode when installing Microsoft SQL Server, you can use SQL Server Authentication to access remote database.
  - When using SQL Server Authentication, you must use silent or unattended setup to install FactoryTalk AssetCentre version 11.00.00 or later.

- If you will configure the FactoryTalk AssetCentre Server to use a remote SQL database, ensure that a standalone managed service account or a group managed service account has been created in your Windows Active Directory.

- Ensure that the Windows account of the user performing the installation, or a Windows group of which the user performing the installation is a member, is assigned the Microsoft SQL Server System Administrator role before attempting the installation.

FactoryTalk AssetCentre Agent

- You must have the appropriate Rockwell Automation software for your devices installed on the agent computer to run Disaster Recovery schedules.

To perform a custom installation of FactoryTalk AssetCentre

1. Log on to your server computer as an administrator, or as a user with administrative privileges.
2. If necessary, close all open Windows programs, and then place the FactoryTalk AssetCentre Installation DVD in the computer's DVD drive.
   
   Tip: You can also select FactoryTalk AssetCentre Server to download the software from the Rockwell Automation Product Compatibility and Download Center.

   Run D:\setup.exe, where D\ is the drive containing the DVD.
3. Select AssetCentre Custom Installation.
4. Select Customize.
5. On the Customize page, select the components. There may be three options shown:
   - **Mandatory** (grayed-out and selected check box) indicates software that will be automatically installed as part of the selected application.
- **Recommended** (selected check box) indicates software that Rockwell recommends for the application. You may decide to clear the check box, so the software does not install.
- **Optional** (clear check box) indicates software that you may wish to include depending on your system. Select the box to include the software during installation.

For more information about the components’ installation, refer to:
- [Steps to install the FactoryTalk AssetCentre Server software](#) on page 25
- [Steps to install the FactoryTalk AssetCentre Agent software](#) on page 32
- [Steps to install FactoryTalk AssetCentre Client software](#) on page 40

6. Select the location for the software. The default location is `C:\`.
7. Select **Next**.
8. Follow the on-screen instructions to complete the installation.

When configuring FactoryTalk AssetCentre Server database, you need to pay attention to the potential security risks of turning off HTTPS.

**WARNING:** We recommend that you turn on HTTPS. The potential security risks of turning off HTTPS are as below:
- The data is transmitted without encryption across a network, which will cause leakage of information, if other solutions, such as IPSEC, are not used.
- The system may be vulnerable to a Remote Code Execution (RCE) attack.

For more information on the installation of the FactoryTalk AssetCentre server, refer to [Install the FactoryTalk AssetCentre Server software](#) on page 19.
For more information on the installation of the FactoryTalk AssetCentre agents, refer to [Install the FactoryTalk AssetCentre Agent software](#) on page 31.
For more information on the installation of the FactoryTalk AssetCentre server, refer to [Install FactoryTalk AssetCentre Client software](#) on page 39.

**After the installation of FactoryTalk AssetCentre software**

- **HTTPS configuration**
  If you have HTTPS turned on during the installation of FactoryTalk AssetCentre, you must [Configure the TLS protocol for FactoryTalk AssetCentre](#) on page 83. We recommend that you use a TLS certificate signed by a certificate authority (CA) to secure the communication.

- **Install the latest FactoryTalk AssetCentre patches**
  For more information about the latest FactoryTalk AssetCentre patches, see Knowledgebase Document ID: QA15600 - FactoryTalk AssetCentre Patch Roll-up for 3.0 and later.
Install the AssetCentre Diagnostics Connector

If you want the Event and Audit information generated by other Rockwell Automation software products in the same FactoryTalk Directory to be recorded in the FactoryTalk AssetCentre database without installing the full FactoryTalk AssetCentre client, install the AssetCentre Diagnostics Connector. The AssetCentre Diagnostics Connector includes only those FactoryTalk AssetCentre components that are necessary to send the Event and Audit log the AssetCentre database.

A typical use of this feature is to send audit records from a FactoryTalk View Site Edition client to the Factory Talk AssetCentre database without installing the full FactoryTalk AssetCentre client.

Steps to install the AssetCentre Diagnostics Connector

The Setup wizard installation process includes the following steps:

- **Step 1: Launch the Setup wizard and select what to install** on page 45
- **Step 2: Read and accept license agreements** on page 46
- **Step 3: Start the installation** on page 46
- **Step 4: Finish the installation** on page 46

Step 1: Launch the Setup wizard and select what to install

1. Log on to your server computer as an administrator, or as a user with administrative privileges.
2. If necessary, close all open Windows programs, and then place the FactoryTalk AssetCentre Installation DVD in the computer's DVD drive.
   - Tip: You can also select FactoryTalk AssetCentre Server to download the software from the Rockwell Automation Product Compatibility and Download Center.
   - Run D:\setup.exe, where D\ is the drive containing the DVD.
3. Select **AssetCentre Diagnostics Connector (Optional)**.
4. To install all components available in the selected component using the recommended settings, click **Install now** and skip to **Step 2: Read and accept license agreements** on page 46.
5. To select which components to install, select **Customize**.
6. On the **Customize** page:
   - **AssetCentre Common Components** are what you need to install as the diagnostics connector.
7. Select the location for the software. The default location is C:\.
8. Select **Install**.
Step 2: Read and accept license agreements

End-user license agreements (EULA) spell out your rights and responsibilities. Depending on the components being installed, there may be more than one license agreement on this page. The individual license agreements are listed above the text box.

Some software products may be delivered or made available only after you agree to the terms and conditions of each of the license agreements.

1. On the **End User License Agreements** page, select each agreement and read the agreement carefully.
2. When all license agreements have been read, select **Accept All**.

Step 3: Start the installation

After accepting the license agreements, the Setup wizard automatically installs all the Rockwell Software applications selected previously. No further user input is required.

Step 4: Finish the installation

Restart the computer to complete the installation.
Chapter 7

Upgrade FactoryTalk AssetCentre

If you upgrade from a previous version of FactoryTalk AssetCentre, use the following steps to upgrade from FactoryTalk AssetCentre versions 7.00.00 and later to version 12.00.00.

- To upgrade an RSMACC system to FactoryTalk AssetCentre, follow the instructions in Knowledgebase Document ID: IN3311 - Upgrade an existing RSMACC system to FactoryTalk AssetCentre.

Important information related to upgrading

Starting from FactoryTalk AssetCentre version 10.00.00, process device capabilities are not supported.

To ensure a successful FactoryTalk AssetCentre Server installation, you must make sure the FactoryTalk Directory Server is running the correct software version and is available before attempting the FactoryTalk AssetCentre Server installation. Otherwise, the upgrading of FactoryTalk AssetCentre Server will fail.

After upgrading from FactoryTalk AssetCentre version 9.00 or earlier to version 10.00 and later, General DTM Device, Equipment, Instrument, Loop, System, and Test Instrument process devices are not available in the asset catalog. The Process Device Configuration Field Edition, ProcalV5 Data Source Configuration, and Procal DB Connector Installer will be removed.

If Process Device Configuration is required for your system, we recommend you considering Endress+Hauser FieldCare which offers a comprehensive tool for managing process instruments called FieldCare SFE500. Endress+Hauser FieldCare is scalable, which allows to fulfill tasks from Device Setup to Plant Asset Management. FieldCare can be used with instruments communicating via Profibus-PA, Foundation Fieldbus, and HART.

All calibration records and information are retained in ProCalV5, thus the previously existing process device assets will be displayed in the asset tree. You can still cut, copy, and paste the existing process devices in the asset tree. However, their hardware and asset properties will be disabled. The ProCalV5 Company and ProCalV5 Linked Item properties of Instrument, Equipment, Loop, System, and Test Instrument are removed from the asset properties dialog box. Process devices will still consume the capacity activation. If you are still owning FactoryTalk AssetCentre Calibration Management, we recommend you contacting the following vendors for more solutions:

- Prime Technologies (https://www.primetechpa.com/)
- CompuCal (https://compucalcalibrations.com/)

When upgrading FactoryTalk AssetCentre to version 9.00.00 and later, the logon user of the FactoryTalk AssetCentre AgentController service will be set to the default LocalSystem no matter what the previous logon user
was. Do not change the default LocalSystem logon user. Doing so will cause disaster recovery schedule failures of FactoryTalk View Site Edition assets.

When upgrading FactoryTalk AssetCentre to version 10.00.00 and later, the FactoryTalk AssetCentre VerificationAgent service will be reset to the default LocalSystem account regardless of the previous configuration. If the previous service configuration was configured to use a user account, such as AssetCentre_DR, it is required to open Agent Controller Launch Control Panel to re-configure the VerificationAgent to use a user account.

If upgrading from a previous version of FactoryTalk AssetCentre, your customized settings will be kept. If repairing the components of FactoryTalk AssetCentre, your customized settings will be restored to the default.

In rare situations, especially on low-performance computers, a dialog box may open during the installation when upgrading FactoryTalk AssetCentre. The dialog box indicates that the FactoryTalk AssetCentre server service needs to be stopped. If you use the unattended setup to upgrade FactoryTalk AssetCentre, you need to click Yes to stop the service or click No to cancel the installation.

**Upgrade to a new version of FactoryTalk AssetCentre retaining existing database server**

To upgrade FactoryTalk AssetCentre to version 11.00.00 or later with a new database server, AssetCentre server will be configured with Windows service accounts (virtual accounts, standalone managed service accounts, and group managed service accounts), or SQL Server accounts.

---

**IMPORTANT** To upgrade FactoryTalk AssetCentre to version 11.00.00 or later with SQL Server Authentication, FactoryTalk AssetCentre installer will create AssetCentreUser and AsseCentreDBMaintenance for upgrading. You must use silent or unattended setup to install it and know the risks of SQL Server Authentication:

- The number of failed sign-in attempts from attackers will cause a user account to be locked.
- The encrypted SQL Server Authentication login password, must be passed over the network at the time of the connection. Some applications that connect automatically will store the password at the client. These are additional attack points.
- Windows offers additional password policies that are not available for SQL Server logins.

---

If you turn on TLS for secure communication within the FactoryTalk AssetCentre system, you must also configure a certificate for encrypted connection between the SQL Server and the FactoryTalk AssetCentre Server computer when the SQL Server is not installed on the FactoryTalk AssetCentre Server computer. For more information, see Configure the certificate for encrypted connection to the database on page 21.

**To configure the FactoryTalk AssetCentre Server**

1. In the Database Server box, enter the name of the database server.
   - For the local database server
     
     If you selected the default instance during the Microsoft SQL Server installation, keep the default name of the database server as (local).
If you customized the instance during the Microsoft SQL Server installation, you need to enter the database server name. For example, WIN-2B92QFPB9C0\SQLSERVERTEST. SQLSERVERTEST is the customized instance name.

- For the remote database server

Enter the name of a remote database server, or in the Location list, choose the location of the remote database server you ever used.

**IMPORTANT**
The default port used for SQL Server communication is 1433. If you want to change the SQL Server port, you must add the port number after the the SQL Server name during installation. For example, mySQLServer,1526. The comma (,) is required. You must ensure that the port is not in use by any other application, service, or process in your system.

2. Select **Next**.

3. On the Configure AssetCentre Server database page, select **Next**.

   When the SQL Server is remote from the FactoryTalk AssetCentre Server, do the following:

   a. On the Configure AssetCentre Server database page, select **Add**.

   b. In the **Select Service Account** dialog box, select **Advanced**, and then select **Find Now**.

   c. In the **Search results** box, select the sMSA or gMSA created, and then select **OK**.

   d. On the Configure AssetCentre Server database page, select **Next**.

   ![Note:](image)

   Note: If you turn on TLS for secure communication within the FactoryTalk AssetCentre system and use a self-signed certificate, you need to enter the full computer name of the Database Server.

   For more information, see [Step 2: Configure the FactoryTalk AssetCentre Server on page 27](#).

**To configure TLS setting**

1. On the **Configure AssetCentre Server** page, make sure the **Secure communication with TLS** check box is selected.

   ![Warning](image)

   **WARNING:** If you don't want use HTTPS, clear the **Secure communication with TLS** check box. The potential risks of turning off HTTPS are as below:

   - The data is transmitted without encryption across a network, which will cause leakage of information, if other solutions, such as IPSEC, are not used.
   - The system may be vulnerable to a Remote Code Execution (RCE) attack.

2. Select **Install**.

After upgrading to FactoryTalk AssetCentre to version 11.00.00 or later and the HTTPS is turned on, you can do the following:
If the TLS certificate is already configured on your computer, it is recommended to select the **Require SSL** check box through **Internet Information Services (IIS) Manager**.

If the TLS certificate is not configured, you must **Configure the TLS protocol for FactoryTalk AssetCentre** on page 83. We recommend that you select the **Require SSL** check box through **Internet Information Services (IIS) Manager**.

**IMPORTANT** After configuring the TLS certificate, you must manually restart **FactoryTalk AssetCentre Server** service through **Control Panel > System and Security > Administrative Tools > Services**, or restart your computer.

---

**Back up FactoryTalk AssetCentre with Microsoft SQL Server**

Proper retention of data is a mission critical task in any industry. For FactoryTalk AssetCentre, this means backing up the data stored in the FactoryTalk AssetCentre database and LLumin database. The information in FactoryTalk AssetCentre, from audits and events, to the asset tree itself, is stored in the **AssetCentre database** within the Microsoft SQL (MSSQL) server. The information of Management of Change is stored in **LLumin database** within the Microsoft SQL (MSSQL) server. The following instructions use FactoryTalk AssetCentre database as an example. The instructions also apply to LLumin database.

**Planning an AssetCentre Maintenance Window**

When backing up any production system, such as FactoryTalk AssetCentre, it is critical to plan the event as a scheduled maintenance window. A maintenance window is a period of time that is planned to make a production system unavailable to its users, thus allowing for proper maintenance to that system to ensure continued system
During the backup of the FactoryTalk AssetCentre system, user access should be limited. While users can continue to query the system during the backup, it is not recommended to have any user activity occur during this time. Fortunately, the Microsoft SQL server is capable of handling user queries of a database it is currently backing up, meaning that the FactoryTalk AssetCentre system does not need to be stopped in order to proceed with a backup.

**Backing Up FactoryTalk AssetCentre in Microsoft SQL Server 2019**

The following set of instructions is intended for use on systems using Microsoft SQL Server 2019. Proper steps for manual backup of the AssetCentre database and the accompanying transaction log will be shown. A backup operation will essentially create a copy of the current database contents, and store them in a user-defined location. It should be noted that this process can also be automated, which is covered at the end of this section.

**AssetCentre Database Backup**

During the backup of the FactoryTalk AssetCentre system, user access should be limited. While users can continue to query the system during the backup, it is not recommended to have any user activity occur during this time. Additionally, it is advisable to run the Database Cleanup Wizard from the FactoryTalk AssetCentre client prior to backing up the system to clean out any aged data that no longer needs to be retained (see online help in FactoryTalk AssetCentre client for this procedure.)

1. From the **Start** menu, select **SQL Server 2018 Management Studio**.

2. Click **Connect**.

   ![Connect to Server](image)

   **SQL Server**

   **Server type:** Database Engine
   **Server name:** WIN-ZB920F89C0\SQLExpress
   **Authentication:** Windows Authentication
   **User name:** WIN-ZB920F89C0\Administrator
   **Password:**

   ![Connect button](image)
3. Once the Microsoft SQL Server 2018 Management Studio has connected to the database server, navigate to the **AssetCentre** database.

4. Right-click on the **AssetCentre database** and then select **Tasks > Back Up...**
5. The Back Up Database – AssetCentre screen is displayed, Observe the following information:

![Back Up Database - AssetCentre Screen](image)

6. Note the Media Options and Backup Options from the tree on the left of the screen. In this example, all options are left at default.

![Select a page - General, Media Options, Backup Options](image)

7. Click OK to initiate the backup.

8. Note the Progress panel in the bottom left of the screen.

![Connection and Progress Panel](image)
9. Upon successful completion of the backup, the following window will be displayed.

![Microsoft SQL Server Management Studio]

The AssetCentre database is now backed up.

**AssetCentre Database Transaction Logs Backup**

It is strongly recommended to backup the database transaction logs in addition to the database itself. The transaction logs essentially keep audits of the database, recording actions performed upon it. Both the transaction logs and database can be stored in the same file, specified in the section above on how to back up the database.

1. Right-click on the **AssetCentre database**, and then select **Tasks > Back Up...**

The following screen will be displayed:
2. Note the **Media Options** and **Backup Options** from the tree on the left of the screen. In this example, all options are left at default.

![Select a page - AssetCentre](image)

3. Click **OK** to initiate the backup.

Note the **Progress** panel in the bottom left of the screen.

4. Upon successful completion of the backup, the following window will be displayed, click **OK**.

![Microsoft SQL Server Management Studio](image)

The AssetCentre database's transaction logs have now been backed up successfully. Repeat step 1-4 to backup the LLumin database transaction logs.

**Scheduling Backups**

Using the Microsoft SQL Server Agent, it is possible to schedule backups of the AssetCentre database and transaction logs on a user defined schedule. Typically, an entire database backup is scheduled less often than the transaction log backup (for example, the database might be backed up weekly, whereas the transaction logs are backed up daily.)

Since the Microsoft SQL Server Agent is performing the operation, its service must be running. It is recommended to set this service to automatic, such that the service will start on reboots without user intervention.

*Note: The steps below assume a configuration of two separate maintenance plans: one for the transaction log and one for the database itself. It is possible to configure both in the same plan.*
1. Ensure that the SQL Server Agent is started. This can be accomplished directly from the Microsoft SQL Server Management Studio, at the bottom of the navigation tree.

2. If the Agent is not started, right-click on it, and then select **Start**.

3. Click **Yes** when prompted to start the service.
4. Once the SQL Server Agent is started, right-click on **Management > Maintenance Plans**, and then select **Maintenance Plan Wizard**.

5. Enter **AssetCentre_DB_Backup** as the name for the maintenance plan, and then click the **Change** button to schedule the plan.
6. Use the following screen to configure the schedule for the operation, then click **OK** to continue.

![New Job Schedule](image1)

7. Click **Next** to progress past this screen now that the schedule is configured.

8. Select **Back Up Database (Full)** to configure this maintenance task to back up the database itself. Click **Next** to continue.

![Select Maintenance Tasks](image2)
9. Click **Next** again.
10. Select the **AssetCentre** database from the drop down menu and click **OK**.

![Image of Define Back Up Database (Full) Task]

11. Under **Create a backup file for every database**, specify the location to store the backup file.
   - Note: A preferred location would be a separate hard drive from the one on which the database resides (thus saving the backup location if the database’s hard drive fails.)

12. Click **Next**.
13. Enter the location to save the log files of the backup.
14. Click **Next**.
   - Note: It is possible to configure email reporting from this screen.
15. Click **Finish** to finalize the maintenance plan.

16. When complete, the following screen will be displayed:

17. Once the success of the operation is reported, click **Close**.
18. A database backup has now been scheduled.

   Note: If a maintenance plan for the transaction log is also desired, simply follow these steps again and select Back Up Database (Transaction Log) instead of Back Up Database (Full).
**Restore FactoryTalk AssetCentre in Microsoft SQL Server 2019**

Before beginning the process of restoring the database, all users of the FactoryTalk AssetCentre system should be disconnected. It is advisable to simply stop the FactoryTalk AssetCentre server service until the Microsoft SQL database restore and subsequent re-connecting of the FactoryTalk AssetCentre server is complete. Additionally, the World Wide Web Publishing service should be stopped until the entire procedure is complete.

**IMPORTANT** We recommend that you back up the database whether moving the database or not.

1. To disable the FactoryTalk AssetCentre server service, open up the Service Control Manager (Start > Services).
2. Right-click on the **FactoryTalk AssetCentre Server** listing and select **Stop**.


4. Return to the SQL Server Management Studio
5. Right-click on **Databases**, then select **Restore Database**.

6. Select **Device**, and then click the **Browse** button.

7. Click **Add**.
8. Browse to the location where you store the backup file, and then select it, then press OK twice to continue.
9. The backup list below the browse button will populate. Check all check boxes.

Note: If different options are selected, such as overwriting on each backup, or if a previous backup file is used, there will be a different number of rows to select from. Additionally, if no transaction logs were backed up, there may only be one checkbox available, corresponding to the AssetCentre database itself. It is also possible to perform restores of just the transaction log or database, depending on the checkbox selections. These steps show the process for restoring both at the same time.

10. Click Media Options.
11. Select **Overwrite the existing database**.

12. Click **OK**. SQL will now restore the AssetCentre database. Progress is reported at the top of the window:

![Restore Database - AssetCentre](image)

**Use Data Source Configuration Wizard to update a SQL user account**

If the AssetCentre database has been moved or restored on a Microsoft SQL Server, it is important to reconnect the FactoryTalk AssetCentre server to this new database. The steps below will walk through the FactoryTalk AssetCentre Data Source Configuration Wizard, installed by default along with the FactoryTalk AssetCentre server.

![Restore Database - AssetCentre](image)

*Note: The FactoryTalk AssetCentre server and World Wide Web Publishing services should still be stopped at this point, following the restoration of the database. If this is not so, stop them now.*
1. From the FactoryTalk AssetCentre server machine, go to the **Start** menu and select **Data Source Configuration**.

2. Click **Next** on the first screen.

3. Enter the name of the Microsoft SQL Server in the **FactoryTalk AssetCentre SQL Server** dropdown menu, and then click **Next**.

Note:
- If you want to turn on the TLS for the database, the fully qualified domain name (FQDN) computer name is required when you specify the FactoryTalk AssetCentre SQL server.
- The default port used for SQL Server communication is 1433. If you want to change the SQL Server port, you must add the port number after the FQDN SQL Server name. For example, `mySQLServer.myDomain.com:1526`. The comma (,) is required.
- You must ensure that the port is not in use by any other application, service, or process in your system.
4. Configure the **Account name** and communication security options as needed, and then click **Next**.

5. Configure the FactoryTalk AssetCentre SQL Server Mirror properties if applicable, and then click **Next**.

Note: If the **Enable SQL Mirroring** check box is selected, in the FactoryTalk AssetCentre SQL Server Mirror box, you can enter a name of Mirror Database Server or SQL Server Mirror that hosts the mirrored FactoryTalk AssetCentre Database.
6. Confirm the **Database name** and **Connection Timeout** values in the FactoryTalk AssetCentre SQL Server window, and then click **Next**.

7. Click **Finish**, and a data source test window will appear.
8. Press **Test Data Source** to test the connection that you’ve just configured and verify that the test completes successfully.

9. Click **Done** to close the wizard.
10. Finally, start the FactoryTalk AssetCentre and World Wide Web Publishing services. From the **Start** menu, open the **Services** program. Start the World Wide Web Publishing service first. Right-click on the World Wide Web Publishing listing and select **Start**.

![Services Program](image)

11. Start the FactoryTalk AssetCentre Server service in the same way.

The FactoryTalk AssetCentre Server is now connected to the newly restored database.

**Command-line parameters for Data Source Configuration Wizard**

Use command-line parameters to configure Data Source Configuration Wizard.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/m</td>
<td>Specifies the password for the FactoryTalk AssetCentre user and FactoryTalk AssetCentre database maintenance user, or generates a random password.</td>
</tr>
<tr>
<td>/SqlAdmin</td>
<td>Specifies the Microsoft SQL Server administrator account name. The Windows authentication is used by default to start Data Source Configuration Wizard.</td>
</tr>
<tr>
<td>/SqlAdminPwd</td>
<td>Specifies the Microsoft SQL Server administrator account password.</td>
</tr>
<tr>
<td>/SqlUserPwd</td>
<td>Specifies the password for the FactoryTalk AssetCentre user.</td>
</tr>
<tr>
<td>/SqlMaintainPwd</td>
<td>Specifies the password for the FactoryTalk AssetCentre database maintenance user.</td>
</tr>
</tbody>
</table>

Example:

```
• Generate a random password for the FactoryTalk AssetCentre user and FactoryTalk AssetCentre database maintenance user and start Data Source Configuration Wizard with Windows or SQL Server authentication.
  
  For Windows authentication
  
  RockwellAutomation.FTAssetCentre.DataSourceEditWizard.exe /m

  For SQL Server authentication
  
  RockwellAutomation.FTAssetCentre.DataSourceEditWizard.exe /m /SqlAdmin=sa
  /SqlAdminPwd=rockwell123@RA

• Specify a password for the FactoryTalk AssetCentre user and start Data Source Configuration Wizard with Windows authentication.

  RockwellAutomation.FTAssetCentre.DataSourceEditWizard.exe /m
  /SqlUserPwd=rockwell123@RA

• Specify a password for the FactoryTalk AssetCentre database maintenance user and start Data Source Configuration Wizard with SQL authentication.

  RockwellAutomation.FTAssetCentre.DataSourceEditWizard.exe /m /SqlAdmin=sa
  /SqlAdminPwd=rockwell123@RA /SqlMaintainPwd=rockwell123@RA

**Move existing database to new server**

Backup the FactoryTalk AssetCentre database and LLumin database before making any changes to your system configuration.

Ensure that the following components are installed on the new server computer before installing the FactoryTalk AssetCentre server components:

- Microsoft Internet Information Services (IIS)
- Microsoft SQL Server
  
  **Note:** If you are upgrading your system to a new version of Microsoft SQL Server you will need to include the Integration Tools of the Microsoft SQL server installation to ensure SQL can successfully migrate a database to the new version.

The following instructions use FactoryTalk AssetCentre database as an example. The instructions also apply to LLumin database.

**To update FactoryTalk AssetCentre database to new version on a new server**

1. Move the FactoryTalk AssetCentre database backup (.BAK) file from the old server to the new server.
2. Use the Microsoft SQL Server Management Studio on the new server to restore the .bak file to this server, for more information on how to backup and restore a Microsoft SQL database, see [Backing up and Restoring FactoryTalk AssetCentre with Microsoft SQL Server](#) on page 50.
3. On the new server from the SQL Management Studio expand the **AssetCentre Database > Security** folder.
4. Find the **AssetCentreUser** user and delete this user from the newly restored database.
5. Click **Yes** when asked to delete the associated schema with this user.

  **Note:** This user must be deleted as the installation of the AssetCentre server installation will re-create a new AssetCentreUser tied to the AssetCentre Server instance running on this system.
When the **AssetCentreUser** has been removed from the AssetCentre database, the AssetCentreUser SQL login user is also deleted.

6. Proceed with the AssetCentre Server installation, see Install the FactoryTalk AssetCentre Server software on page 19.

   Note: After upgrading FactoryTalk AssetCentre from previous version to version 10.00.00 and later, and restarting your computer, you can check the SDF file to confirm whether the migration from SDF to MDF succeeded. If the size of the SDF file is still large (for example, more than 1GB), in the Control Panel, you can repair FactoryTalk AssetCentre Common Components to restart the migration.

**Optional software upgrades**

If earlier versions of the following software are installed on your computer, and they are lower than the minimum versions required to install FactoryTalk AssetCentre, the FactoryTalk AssetCentre Setup wizard will upgrade the software automatically.

- RSLogix Classic Lite
- Logix Designer Compare Tool
- FactoryTalk View ME Transfer Utility
- RSLogix 5
- RSLogix 500

If the software versions are equal to or higher than the minimum versions required to install FactoryTalk AssetCentre, but lower than the versions included in the FactoryTalk AssetCentre installation package, the installation process will not upgrade the software automatically. If you want to use the latest versions instead, you must select the software check boxes during the installation of FactoryTalk AssetCentre.

Tip: If you use FactoryTalk Services Platform CPR 9 SR 13, be sure to use the CPR 9 SR 13 versions of RSLogix Enterprise and RSLogix Classic Lite.

If you want to upgrade the optional software products, we recommend that you upgrade them before installing FactoryTalk AssetCentre.
Use silent or unattended setup to install the FactoryTalk AssetCentre software

FactoryTalk AssetCentre supports silent or unattended installation. Silent installation runs in a quiet mode without any user interface, while unattended installation runs in a quiet simple mode and shows progress through the UI. Unattended installation does not accept any input, but still shows error or restart messages.

**IMPORTANT** Before starting silent or unattended setup to install the FactoryTalk AssetCentre software, ensure that your Windows Active Directory (AD) user account has been assigned the SQL Server system administrator (SA) role.

Use command lines to specify properties to install FactoryTalk AssetCentre software automatically with little interaction. The silent or unattended installation supports the following installation modes:

- FactoryTalk AssetCentre server
- FactoryTalk AssetCentre agent
- FactoryTalk AssetCentre client
- FactoryTalk AssetCentre custom installation

Tip: Unlike custom installation using the standard Setup wizard that allows you to select software products to install, the custom installation mode in silent or unattended setup automatically installs all FactoryTalk AssetCentre software, including FactoryTalk AssetCentre server, client, and agent.

If you install FactoryTalk AssetCentre client or agent with RSLinx Classic using silent or unattended installation on 32-bit operating systems, you must manually install the USB CIP package first. To manually install the USB CIP package, run it from FactoryTalk AssetCentre installation directory: `\Redist\USBCIP_3.18.06\Setup.exe`

During the silent or unattended installation, all associated Rockwell Automation software processes will be forcibly ended automatically. Make sure to shut down all associated Rockwell Automation software products before installation.

This chapter describes how to use silent or unattended setup to install the FactoryTalk AssetCentre software. If you want to use the standard Setup wizard to install the software step by step, see Chapter 4 through Chapter 7 for detailed instructions.
Before performing the silent or unattended installation

This section describes things you need to know:

- Before you install the FactoryTalk AssetCentre Server software using silent or unattended setup on page 74
- Before you install FactoryTalk AssetCentre Agent software using unattended silent or setup on page 75
- Before you install the FactoryTalk AssetCentre Client software using silent or unattended setup on page 75

For current information on the system requirements for the FactoryTalk AssetCentre software, see FactoryTalk AssetCentre Release Notes and the Product Compatibility and Download Center.

Before you install the FactoryTalk AssetCentre Server software using silent or unattended setup

The following checklist summarizes the basic tasks involved in the unattended installation of FactoryTalk AssetCentre Server software along with supporting software.

- Ensure that the user performing installation has administrative rights in Windows.
- Ensure that a Microsoft SQL Server is available, and it is already installed on the same computer as the intended FactoryTalk AssetCentre Server, or on a separate Microsoft Windows server.
- Ensure that the Windows account of the user performing the installation, or a Windows group of which the user performing the installation is a member, is assigned the Microsoft SQL Server System Administrator role before attempting the installation.
• If you will configure the FactoryTalk AssetCentre Server to use a remote SQL database, ensure that a standalone managed service account or a group managed service account has been created in your Windows Active Directory.

Before you install FactoryTalk AssetCentre Agent software using silent or unattended setup

Agents are programs that communicate with the FactoryTalk AssetCentre server and perform scheduled tasks on behalf of the FactoryTalk AssetCentre server. Agents allow work to be distributed and shared among multiple computers to spread processing load and speed up operations. When a server needs an agent to perform a task, it locates the computer running the operation and assigns the task to that agent. The agent then reports the task’s completion to the server. The Search feature, as well as purchased capabilities, such as Disaster Recovery capabilities, require the use of agents to perform scheduled operations.

Where to install the FactoryTalk AssetCentre Agent software

Agents can be installed on any computer that:

• Is capable of running the FactoryTalk AssetCentre Agent software (see Agent computer requirements on page 15).
• Is connected to the FactoryTalk AssetCentre server.
• Runs the FactoryTalk AssetCentre server, or the FactoryTalk AssetCentre client.

If you also want to install Logix Designer Compare Tool, you need to manually install .NET Framework 3.5 before installing the agent on the following operating systems:

• Windows Server 2022
• Windows Server 2019
• Windows Server 2016
• Windows Server 2012 R2
• Windows 10

See Before you install the FactoryTalk AssetCentre Agent software on page 31 for more information about FactoryTalk AssetCentre Agent software.

Before you install the FactoryTalk AssetCentre Client software using silent or unattended setup

The FactoryTalk AssetCentre Client software provides the user interface for FactoryTalk AssetCentre. It is through the client that you perform tasks such as checking files in and out, creating and running scheduled events, and viewing logs. For more information on what you can do with FactoryTalk AssetCentre client software, see the FactoryTalk AssetCentre Help (once the client is installed).

Install the FactoryTalk AssetCentre client software on all computers on which you want to use FactoryTalk AssetCentre.
The client is not required on the FactoryTalk AssetCentre server computer, but you can install it on the server if desired.

**Install the client on any computer**

- From which you want to access the FactoryTalk AssetCentre Client software (to edit the representation of your assets, to view logs, to create schedules, to search the logs, and so on).
- That is capable of running the FactoryTalk AssetCentre Client software (see [Client computer requirements](#) on page 14).
- That is connected to the FactoryTalk AssetCentre server.
- From which FactoryTalk audits are desired.

The Disaster Recovery capability provides the ability to schedule a comparison between master files, and processor program and data files. To edit the file and data settings for a compare operation for PLC-5, SLC 500, or MicroLogix processors, you must have RSLogix 5, or RSLogix 500 software installed on the client computer.

**Perform silent or unattended installation**

Use command-line parameters to perform a silent or unattended installation of the software.

The command-line installation requires the administrator permission. The steps may vary slightly depending on your operating system.

**WARNING:** HTTPS is turned on by default during silent or unattended installation. If you don't want to use it, you can turn it off with `/noHTTPS`. The potential security risks of turning off HTTPS are as below:

- The data is transmitted without encryption across a network, which will cause leakage of information, if other solutions, such as IPSEC, are not used.
- The system may be vulnerable to a Remote Code Execution (RCE) attack.

**To perform silent or unattended installation**

1. Close all Windows programs.
2. Open the **Command Prompt** window.
3. In the **Command Prompt** window, navigate to the drive containing the FactoryTalk AssetCentre installation package.
   
   In this example, type `D:` where `D:` is the logical drive or volume, and press **Enter**.

   Tip: If **User Account Control** dialog box shows, click **Yes**.

4. Type a command with the following syntax:

   ```
   ```

   **Example:**
   ```
   D:\12.00.00-FTAssetCentre-DVDD\Setup.exe /Q /IAcceptAllLicenseTerms /SetupLanguage=ENU /Product="AssetCentre Server" /InstallDrive=D:
   ```
Perform silent or unattended installation with Windows Authentication and access database with SQL Authentication


Example:
D:\12.00.00-FTAssetCentre-DVDD\Setup.exe /Q /IAcceptAllLicenseTerms /SetupLanguage=ENU /Product="AssetCentre Server" /InstallDrive=D: /SqlServer="RemoteInstance" /sa /SqlAdmin="sa" /SqlAdminPwd="SqlAdminPwd" /MSA="RA\FTACgMSA$" /FTSPWebAuth=yes /ReverseProxy=yes /FTSPWebEventServer=yes /DirectoryServer=FTDIRECTORY /AutoRestart

Perform silent or unattended installation with SQL Authentication and access database with Windows Authentication


Example:
D:\12.00.00-FTAssetCentre-DVDD\Setup.exe /Q /IAcceptAllLicenseTerms /SetupLanguage=ENU /Product="AssetCentre Server" /InstallDrive=D: /SqlServer="RemoteInstance" /sa /SqlAdmin="sa" /SqlAdminPwd="SqlAdminPwd" /MSA="RA\FTACgMSA$" /FTSPWebAuth=yes /ReverseProxy=yes /FTSPWebEventServer=yes /DirectoryServer=FTDIRECTORY /AutoRestart

Perform silent or unattended installation with and access database SQL Authentication


Example:
D:\12.00.00-FTAssetCentre-DVDD\Setup.exe /Q /IAcceptAllLicenseTerms /SetupLanguage=ENU /Product="AssetCentre Server" /InstallDrive=D: /SqlServer="RemoteInstance" /sa /SqlAdmin="sa" /SqlAdminPwd="SqlAdminPwd" /sql /FTSPWebAuth=yes /ReverseProxy=yes /FTSPWebEventServer=yes /DirectoryServer=FTDIRECTORY /AutoRestart

IMPORTANT • When installing FactoryTalk AssetCentre through silent or unattended installation, quotes are required for the parameters with space (for example, /Product="AssetCentre Server").

5. Press Enter.

For more information about parameters, type Setup.exe /? or see Command-line parameters for silent or unattended installation on page 78.
Command-line parameters for silent or unattended installation

Unattended or silent install

Use command-line parameters to perform an unattended or silent installation of the software.

**IMPORTANT** When installing or upgrading FactoryTalk AssetCentre to version 11.00.00 or later with SQL Server Authentication, you must use silent or unattended setup to install it.

Command-line parameters

The following table identifies the installation command-line parameters. Command-line parameters are case-insensitive. However, if a specified value includes a space, be sure to enclose the value in quotation marks (for example, “value with spaces”).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/?</td>
<td>Displays the usage options for installation parameters.</td>
</tr>
<tr>
<td>/Q</td>
<td>Silent Install, install runs in a quiet mode without any user interface. This parameter is recommended if you are deploying the software installation using an IT tool or script, and don't expect to see any error or restart messages. When using this parameter, your IT tool or script should check the error codes and respond as needed. For example, if the installation returns error code 1641, then the IT tool or script should restart the computer and relaunch the installation after restart. This parameter is required if /QS or /Record is not specified.</td>
</tr>
<tr>
<td>/QS</td>
<td>Unattended Install, install runs in a quiet simple mode and shows progress through the UI, it does not accept any input but still shows error or restart messages. When using this parameter, you will not have to check the error codes, and the installation will stop and display a prompt if there are error or restart messages. For example, if an immediate restart is required to complete the install, a restart message will be displayed for you to confirm the restart. Installation resumes automatically from the point of interruption after restart. This parameter is required if /Q or /Record is not specified.</td>
</tr>
<tr>
<td>/IAcceptAllLicenseTerms</td>
<td>Acknowledges acceptance of the license terms. This parameter is required for /Q or /QS parameters.</td>
</tr>
<tr>
<td>/AutoRestart</td>
<td>Automatically restarts the computer after the installation is complete. Used when a restart is required to complete the installation. This parameter is optional. If this parameter is not used silent install (/Q) will return either error code 1641 or 3010 if a restart is required, and unattended install (/QS) will result in a confirmation prompt that must be agreed to before the installation is completed.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| /SetupLanguage="value"        | Specifies which language will be displayed during install process. The value must be the one of the following:  
  • ENU  
  • CHS  
  • DEU  
  • ESP  
  • FRA  
  • ITA  
  • JPN  
  • KOR  
  • PTB  
  This parameter is optional. If this parameter is not used, the default language is the current user or operating system user interface language. |
| /Record                       | Records the installation options chosen to a recording file. This parameter is optional. |
| /Playback                     | Plays back a recording file to specify the installation options. This parameter is optional. |
| /IgnoreWarning                | Specifies that the setup ignores warnings and continues. This parameter is optional. If it is not specified, the setup exits when a warning occurs. |
| /Product="value"              | Specifies which sub-products will be installed. The product name must be one of followings:  
  • AssetCentre Server  
  • AssetCentre Client  
  • AssetCentre Agent  
  • AssetCentre Custom Installation  
  This parameter is optional. |
| /Uninstall                    | Uninstalls the product. This parameter is optional. |
| /ProductLanguage="value"      | Specifies the language version of the software being installed. The value must be the one of the following:  
  • ENU  
  • CHS  
  • DEU  
  • ESP  
  • FRA  
  • ITA  
  • JPN  
  • KOR  
  • PTB  
  This parameter is optional. If this parameter is not used, the default language is the same as the setup language. If the software does not support multiple languages this parameter is not available. |
<p>| /SerialNumber=&quot;value&quot;         | Specifies the serial number of the software being installed. This is used to activate the software during installation. This parameter is optional. If it is not specified the software must be activated manually after installation if activation is required. Some software does not require activation. If activation is not required this parameter is not available. |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/ProductKey=&quot;value&quot;</td>
<td>Specifies the product key used to get activation keys during installation. This parameter is optional. If it is not specified the software must be activated manually after installation if activation is required. Some software does not require activation. If activation is not required this parameter is not available.</td>
</tr>
<tr>
<td>/Version=&quot;value&quot;</td>
<td>Specifies the version of the software to activate which corresponds to the product version associated with the SerialNumber and ProductKey. This parameter is optional. If it is not specified the installer will use the most recent product version available. Some software does not require activation. If activation is not required this parameter is not available.</td>
</tr>
<tr>
<td>/InstallDrive=&quot;value&quot;</td>
<td>Specifies the install drive. This parameter is optional. If this parameter is not used, the default install location is &quot;C:\Program Files (x86)\Rockwell Software&quot;. Some software restricts the installer to only change the drive the software is installed on. Use /? to determine which parameter is supported.</td>
</tr>
<tr>
<td>/ftsp-value=&quot;value&quot;</td>
<td>Specifies the FactoryTalk security policy value. This parameter is optional. Use the enable or disable value to change the state of RequireComputerAccounts during installation.</td>
</tr>
</tbody>
</table>
| /FTSPWebAuth="value" | Specifies that the installation includes the FactoryTalk Web Authentication Server. This parameter is optional. The value must be one of the following:  
 • Yes  
  If the value is Yes, the FactoryTalk Web Authentication Server will be installed. The FactoryTalk Reverse Proxy will also be installed as it is required for operation of the FactoryTalk Web Authentication Server.  
 • No  
  If the value is No, the FactoryTalk Web Authentication Server will not be installed. |
| /ReverseProxy="value" | Specifies that the installation includes the FactoryTalk Reverse Proxy. This parameter is optional. The value must be one of the following:  
 • Yes  
  If the value is Yes, the FactoryTalk Reverse Proxy will be installed.  
 • No  
  If the value is No, the FactoryTalk Reverse Proxy will not be installed. |
| /FTSPWebEventServer="value" | Specifies that the installation includes the FactoryTalk Web Event Server. This parameter is optional. The value must be one of the following:  
 • Yes  
  If the value is Yes, the FactoryTalk Web Event Server will be installed.  
 • No  
  If the value is No, the FactoryTalk Web Event Server will not be installed. |
| /noHTTPS | Specifies that the setup turns off HTTPS and continues. This parameter is optional. |
| /SqlServer="value" | Specifies FactoryTalk AssetCentre database server (Microsoft SQL Server) location. This parameter is required when installing the FactoryTalk AssetCentre server software. |
Parameter | Description
--- | ---
/MSA="value" | Specifies the Group Managed Service Account (gMSA) or Managed Service Account (MSA) that will be used by FactoryTalk AssetCentre Server to access the Microsoft SQL Server database when using Windows Authentication.
- The parameter is required when the Microsoft SQL Server is hosted on a different computer than the FactoryTalk AssetCentre Server.
- The parameter is optional when the Microsoft SQL and FactoryTalk AssetCentre Servers are hosted on the same computer.
/sql | Uses SQL Authentication between the FactoryTalk AssetCentre and Microsoft SQL Servers. The use of SQL Authentication is discouraged due to security concerns. This parameter is required if SQL authentication will be used over MSA.
(sa="value" | Uses SQL Authentication for SQL Server Logins. If you use SQL Server Authentication to perform silent or unattended installation, the parameters /SqlAdmin, /SqlAdminPwd are required.
/SqlAdmin="value" | Specifies the Microsoft SQL Server administrator account name.
/SqlAdminPwd="value" | Specifies the Microsoft SQL Server administrator account password.
/DirectoryServer="value" | Specifies the FactoryTalk network directory if you are using a distributed system. This parameter is optional. If it is not specified, the software will use its current computer as the FactoryTalk Directory server.
The value must be the host name of the FactoryTalk Directory server.

**Error codes**

The following table identifies the error codes that can be returned by an installation.

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERROR_SUCCESS</td>
<td>0</td>
<td>The installation completed successfully.</td>
</tr>
<tr>
<td>ERROR_INVALID_PARAMETER</td>
<td>87</td>
<td>One of the parameters was invalid.</td>
</tr>
<tr>
<td>ERROR_INSTALL_USEREXIT</td>
<td>1602</td>
<td>The installation was cancelled by the user.</td>
</tr>
<tr>
<td>ERROR_INSTALL_FAILURE</td>
<td>1603</td>
<td>A fatal error occurred during installation or the software component to be installed already exists on the computer.</td>
</tr>
<tr>
<td>ERROR_BAD_CONFIGURATION</td>
<td>1610</td>
<td>The configuration data for this product is corrupt. Contact your support personnel.</td>
</tr>
<tr>
<td>ERROR_REBOOT_CONTINUE</td>
<td>1641</td>
<td>A reboot is required to continue to installation.</td>
</tr>
<tr>
<td>ERROR_SUCCESS_REBOOT_REQUIRED</td>
<td>3010</td>
<td>A restart is required to complete the installation. After restart the product is successfully installed.</td>
</tr>
<tr>
<td>ERROR_REBOOT_PENDING</td>
<td>3012</td>
<td>A restart is pending and is required before the installation can continue.</td>
</tr>
<tr>
<td>ERROR_SUCCESS_NOT_APPLICABLE</td>
<td>3013</td>
<td>The installation cannot proceed because the products are already installed.</td>
</tr>
<tr>
<td>ERROR_SUCCESS_WARNING_REBOOT</td>
<td>3014</td>
<td>Install succeed with warnings. Check installation logs for details. A restart is required to complete the installation.</td>
</tr>
</tbody>
</table>

**After the installation using the unattended setup**

You can find the installation logs and view the installation status in the following path:

- On 64-bit operating systems: `C:\Program Files (x86)\Common Files\Rockwell\Install Logs`

Once the installation is complete, you need to activate FactoryTalk AssetCentre. For more information, see Step 6: Finish the installation on page 29.
After the installation using the unattended setup, you can configure FactoryTalk AssetCentre.

For details, see:

- [Configure the TLS protocol for FactoryTalk AssetCentre](#) on page 83
- [Configure FactoryTalk AssetCentre](#) on page 93
Configure the TLS protocol for FactoryTalk AssetCentre

Beginning with FactoryTalk AssetCentre version 12.00.00, it is required to turn on TLS 1.3 for secure communications within the FactoryTalk AssetCentre system.

If all operating systems of the FactoryTalk AssetCentre system support TLS 1.3, you can turn on TLS 1.3 only. However, FactoryTalk AssetCentreWeb Client does not work in this scenario. For the web client to work, turn on TLS 1.2 on the FactoryTalk AssetCentre server computer.

If any of the operating systems of the FactoryTalk AssetCentre system does not support TLS 1.3, turn on TLS 1.2 on the FactoryTalk AssetCentre server computer for all FactoryTalk AssetCentre components to work. We recommend that you disable TLS 1.0 and TLS 1.1 in the system. The supported operating systems will turn on the minimum requirements of TLS protocol for the latest version of FactoryTalk AssetCentre. We strongly recommend that you use a TLS certificate signed by a certificate authority (CA).

For more information about TLS protocol version support, see Protocols in TLS/SSL. For more information about the compatible operating system, see Software requirements on page 13.

### IMPORTANT
- Using the TLS protocol is an essential part for the communication security over your network.
- If you want to configure the protocols as needed, you should use the same protocol for all computers deployed in your network.

The configuration including these steps:

- Install a TLS certificate on page 83
- Configure the HTTPS site binding on page 84
- Configure a firewall rule and web services URL if the default port is modified on page 84

### Install a TLS certificate

The steps to install a TLS certificate may depend on the certificate types and operating systems. The following instruction describes how to install a PFX or CER file on Windows Server 2022.

### To install a PFX file containing the TLS certificate

2. Under IIS, double-click Server Certificates.
3. In the Actions pane, select Import.
4. In the Import Certificate dialog box, select the Browse button.
5. Select the PFX file, and then select **Open**.
6. Enter the password.
7. Select **OK**.

**To install a CER file containing the TLS certificate**

2. Under **IIS**, double-click **Server Certificates**.
3. In the **Actions** pane, select **Complete Certificate Request**.
4. On the **Specify Certificate Authority Response** page, click the **Browse** button.
5. Select the certificate file, and then select **Open**.
6. In the **Friendly** name box, enter a name for the certificate.
7. Select **OK**.

**Configure the HTTPS site binding**

After installing the certificate, ensure that the TLS certificate is selected for the HTTPS site binding.

**To select a TLS certificate for the HTTPS site binding**

1. On the Management of Change, FactoryTalk AssetCentre Server, Agent, and Client, and FactoryTalk AssetCentre Web Client computers, go to **Site Bindings** in the Internet Information Services (IIS) **Default Web Site**.
2. In the **Actions** pane, select **Bindings**.
3. In the **Site Bindings** dialog box, select the HTTPS site binding, and then select **Edit**.
4. From the **SSL certificate** list, select the desired certificate.
5. Select **OK**.

**Configure a firewall rule and web services URL if the default port is modified**

If the default port 443 is modified during the site binding configuration, you need to:

- Configure a Windows firewall rule for the self-defined port.
- Configure the primary server web services base URL.

**To configure a Windows firewall rule**

1. On the FactoryTalk AssetCentre server computer, click **Start**, type **firewall**, and then click **Windows Firewall with Advanced Security**.
2. Click **Inbound Rules**.

---

84  Rockwell Automation Publication - FTAC-IN005K-EN-E - March 2023
3. Click **Action > New Rule**.
4. In the **New Inbound Rule Wizard**, select **Port**, and then click **Next**.

5. In the **Specific local ports** box, enter the self-defined port as set during the site binding configuration, for example 9000, and then click **Next**.
6. Follow the on-screen instructions until you get to the **Name** page.
7. In the **Name** box, enter the name for the new inbound rule, and then click **Finish**.

The new rule is shown in the list.

To configure the primary server web services base URL

1. On the FactoryTalk AssetCentre server computer, click **Start > All Programs > Rockwell Software > FactoryTalk Administration Console**.
2. In the **Explorer**, navigate to **Network > System > Policies > Product Policies > FactoryTalk AssetCentre**, and then double-click **Server Settings**.

3. In the **Server Settings Properties** dialog box, click the **Primary Server Web Services Base URL** box, and then change the computer name part in the form as `MYSERVER:PortNumber`.

4. Click **OK**.
Configure Windows Authentication

Windows Authentication is a secure way of authentication that uses the username and the password of the user logged on to the operating system. In the communication secured with Windows Authentication mode, the username and the password are sent between the client and the server in a strongly hashed form.

Windows Authentication may be enabled in corporate networks that use Microsoft Active Directory services as well as other ways to identify users.

By turning on Windows Authentication mode you increase the security of the communication between the FactoryTalk AssetCentre server, client(s) and agent(s) and prevent unauthorized users from accessing the FactoryTalk AssetCentre server.

Important: For the purposes of FactoryTalk AssetCentre, Windows Authentication mode should be enabled only in corporate networks that use Microsoft Active Directory services.

After you turn on Windows Authentication mode, the access to the page:

http(s)://assetcentre_server_full_name/rockwellsoftware/assetcentre

...will be secured from being accessed by anonymous users.

In order to access the page, the users will need to log on using their Windows username and password.

This chapter describes:

- Turn on Windows Authentication mode in Internet Information Services (IIS) on page 89

Turn on Windows Authentication mode in Internet Information Services (IIS)

To turn on Windows Authentication mode in Internet Information Services (IIS)

1. Open Internet Information Services (IIS) Manager on the FactoryTalk AssetCentre server computer.
   
   a. On the taskbar, click ☑
   b. In the search box, type inetmgr, and then press Enter.
2. Under Connections, expand the tree, and then click AssetCentre.

3. In Features View, double-click Authentication.
5. Under Actions, click Providers.
   
   The Providers dialog box appears.
6. Make sure that you have the following providers selected in the order presented in the figure below.
If these providers are not listed, select each of them in the list under Available Providers, and then click Add.

7. Make sure that all other authentication modes listed in the pane under Authentication are disabled.

IMPORTANT When running FactoryTalk AssetCentre in a workgroup environment, Internet Information Services (IIS) Anonymous Authentication is enabled by default. Anonymous Authentication is required for proper operation of the system.

To mitigate any security-related concerns, you must run FactoryTalk AssetCentre in a domain environment.
Chapter 11

Configure FactoryTalk AssetCentre

This chapter describes:

- Configure for client access to the server on page 93
- Configure feature security for FactoryTalk AssetCentre users on page 95

Configure for client access to the server

For clients to be able to access the FactoryTalk AssetCentre server, the FactoryTalk Directory and FactoryTalk Security must be configured to give clients access. To configure access, you will need to use the FactoryTalk Administration Console.

The FactoryTalk Directory uses two factors to determine who should have access to any given function:

- **The user's account**, which can either be a FactoryTalk Directory account or a Windows domain account. This identifies the user.
- **The computer from which the user is accessing the FactoryTalk Directory**.
  This allows you to limit which computers can access the directory, and also allows you to determine whether certain functions can or cannot be performed from a given computer. For example, you can configure the FactoryTalk Directory to give access to a user from her or his own computer but not from another computer.

At a minimum, you must add the FactoryTalk AssetCentre users and their computers to the FactoryTalk Directory, and you must configure access privileges for FactoryTalk AssetCentre in the FactoryTalk Directory.

Add users to the FactoryTalk Directory

A user must have a FactoryTalk Directory user account in order to use FactoryTalk AssetCentre.

**Tip:** This section contains only basic instructions for using the FactoryTalk Directory and FactoryTalk Security. For background information and information regarding more advanced procedures, please see the Help for the FactoryTalk Administration Console.

By default, all members of the Administrators group on the computers on which you installed the FactoryTalk Services Platform were added to the Administrators group in the FactoryTalk Directory. Also, any rights that you assign to a Windows User Group are assigned to all members of that group.

We recommend that you use a default FactoryTalk Group with Windows AD linked Group. This practice simplifies the process of confirming the security configuration as testing is performed on the default FactoryTalk Group, and policy is written about which Windows user and groups are added to the default FactoryTalk group.
To add a user to the FactoryTalk Directory

1. Start the FactoryTalk Administration Console:
   a. Click Start, and then use search to search for FactoryTalk Administration Console.
   b. Click FactoryTalk Administration Console.
      FactoryTalk Administration Console appears.

2. Log on to the Network directory using a FactoryTalk Administrator account.
3. Open the Users and Groups folder.
4. Under the Users and Groups folder, right-click the Users folder, and then select New.
5. Specify whether you want to create a new FactoryTalk User or a Windows-Linked User.
   - If you choose to use Windows-linked users, consider using Windows AD linked group accounts rather than Windows-linked user accounts if possible. This simplifies the process if you ever move your software to a different domain. You cannot move individual Windows-linked user accounts from one domain to another. You can move Windows-linked group accounts to a new domain, while retaining all of the security permissions for the group. If you change the domain an individual Windows-linked user account belongs to, you must delete the old account, create the new account, and then recreate all of the security permissions for the new account.
   - FactoryTalk user accounts are visible only to the FactoryTalk system and their access is independent of Windows.
   - A Windows-linked user is validated by Windows domain.

A FactoryTalk Security account is the same as a FactoryTalk user account. For more information, see "Accounts and groups" in the FactoryTalk Help.

- If you may need to use FactoryTalk AssetCentre while disconnected from the network, use FactoryTalk Security user accounts. Windows-linked user accounts will not be able to authenticate with the domain while disconnected.

   **Tip:** If you have users who need similar access to features of FactoryTalk AssetCentre, consider grouping users to make assigning security privileges easier. For example, you can group all of your electricians into an Electricians group, and then provide security access for them as a group. For information about grouping users, see the Help for the FactoryTalk Administration Console.

6. Enter the information for the user.

Add computers to the FactoryTalk Directory

When FactoryTalk Services Platform is installed on a computer, that computer is automatically added to the FactoryTalk Network Directory. FactoryTalk Services Platform is included in the FactoryTalk AssetCentre installation, so your client computers should already be in the FactoryTalk Network Directory.

By default, for a user to be able to use FactoryTalk AssetCentre, the user's computer must be in the FactoryTalk Directory. If you want to pre-add user's computers to the system, refer to the FactoryTalk Help in the FactoryTalk Administration Console.
Tip: If you have a significant number of computers for which you need to permit or restrict access, consider grouping them to make assigning security privileges easier. For example, you can group all of the computers used in offices away from the plant floor and restrict access to features that should be used only from computers stationed where the user can see the automation system directly. For information about grouping computers, see the Help for the FactoryTalk Administration Console.

Configure feature security for FactoryTalk AssetCentre users

By default, all users and the Administrators group in FactoryTalk Directory can perform any task in the FactoryTalk AssetCentre software. To deny specific users the right to perform tasks in FactoryTalk AssetCentre, you must edit the Feature Security settings in the FactoryTalk Administration Console.

**IMPORTANT** Never explicitly deny rights to the All Users or Administrators group in FactoryTalk. Rather, set up specific user groups of your own and deny rights to those groups. Denying rights to All Users or Administrators could lock everyone out of the system and would deny rights in all FactoryTalk-enabled products using any FactoryTalk CPR 9 version.

To change which users can perform tasks in FactoryTalk AssetCentre

1. Start the FactoryTalk Administration Console:
   a. Click **Start**, and then use search to search for **FactoryTalk Administration Console**.
   b. Click **FactoryTalk Administration Console**.

   FactoryTalk Administration Console appears.

2. Log on to the Network directory using a FactoryTalk Administrator account.

3. In the **Explorer** pane of the FactoryTalk Administration Console, navigate to **System > Policies > Product Policies > FactoryTalk AssetCentre**.

4. Double-click **Feature Security**.

   **IMPORTANT** here is also a Server Settings object in the FactoryTalk AssetCentre folder. Do NOT attempt to change any of the settings in this object. Doing so may render your FactoryTalk AssetCentre system inoperative. If you need to change server settings (to use a different mail server, for example), from Windows **Start** menu, select **All Programs > Rockwell Software > FactoryTalk AssetCentre Server > Server Settings**.

5. In the **Feature Security Properties** window, click the policy you want to change, and then click the browse button for the policy.
6. In the **Configure Securable Action** dialog box, select the user or group for whom you want to assign permissions. If the user or group does not appear in the list, click **Add**, click **Show all**, select the user or group, and then click **OK**.

7. Click the appropriate box to allow or deny the user permission to the selected feature.

8. Click **OK**.

**Policy settings and their functions**

The following table shows the policy settings and their functions.

<table>
<thead>
<tr>
<th>This policy setting</th>
<th>Controls whether users can</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Address Book</td>
<td>View the Address Book (which contains addresses for the purpose of sending automatic e-mail notifications).</td>
</tr>
<tr>
<td>Edit Address Book</td>
<td>Edit or add contacts and groups in the Address Book (which contains addresses for the purpose of sending automatic e-mail notifications).</td>
</tr>
<tr>
<td>Override Archive Check In</td>
<td>Check in a file regardless of who checked it out or from where it was checked out.</td>
</tr>
<tr>
<td>Configure Database Limitations</td>
<td>Configure the total maximum size of the AssetCentre database, the size warning levels, the maximum number of versions per archive asset, the maximum size of Event, Audit, and Diagnostics logs, and the database capacity status refresh rate.</td>
</tr>
<tr>
<td>Configure Archive Options Settings</td>
<td>Turn on or off the function that allows Logix Designer to perform archive activities, such as file check-in, without direct interaction with the FactoryTalk AssetCentre client.</td>
</tr>
<tr>
<td>Clear the Get Writable Copy check box by default</td>
<td>Enable or clear the Get Writable Copy check box during get. Denying this permission enables the Get Writable Copy check box; a Get retrieves a writable copy of an Archive object. Allowing this permission (by default) clears the Get Writable Copy check box; a Get retrieves a read-only copy of an Archive object.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Override Archive Undo Check Out</td>
<td>Undo a check out even if a different user checked the file out.</td>
</tr>
<tr>
<td>Override Removal of Local Copies</td>
<td>Choose to keep local copies of checked-in files on their computer. If this right is allowed, the user can keep local copies. If this right is denied, the user is not given this option.</td>
</tr>
<tr>
<td>Configure Personal Archive File Associations</td>
<td>Configure which software product launches when opening a particular type of file. If a personal file association is set, it will take precedence over the system file association.</td>
</tr>
<tr>
<td>Configure System Archive File Associations</td>
<td>Configure which software product launches when opening a particular type of file. This setting applies unless the user has specified a personal file association.</td>
</tr>
<tr>
<td>Configure Personal Archive Working Folders</td>
<td>Set a personal working folder for checking out files.</td>
</tr>
<tr>
<td>Configure System Archive Working Folders</td>
<td>Set the system working folder to which all users check out files unless they have a personal working folder.</td>
</tr>
<tr>
<td>Run Archive Database Cleanup Wizard</td>
<td>Run the Archive Database Cleanup Wizard to delete unused versions of files.</td>
</tr>
<tr>
<td>Allow Empty Comment at Check In</td>
<td>Leave the comment field empty as they check in an asset.</td>
</tr>
<tr>
<td>Allow Empty Comment at Check Out</td>
<td>Leave the comment field empty as they check out an asset.</td>
</tr>
<tr>
<td>Store latest version only</td>
<td>Choose to store only the latest version in the Archive.</td>
</tr>
<tr>
<td>Set maximum versions</td>
<td>Configure the total maximum number of versions stored in the Archive.</td>
</tr>
<tr>
<td>Configure Asset Inventory Settings</td>
<td>Configure the settings in the Asset Inventory window.</td>
</tr>
<tr>
<td>Configure Assets Lifecycle Sync</td>
<td>Synchronize life cycle information in the FactoryTalk AssetCentre server and client with the Rockwell Automation lifecycle website.</td>
</tr>
<tr>
<td>Display Calibration Management Data*</td>
<td>View Calibration Management data in FactoryTalk AssetCentre.</td>
</tr>
<tr>
<td>Perform Calibration Management*</td>
<td>Access Calibration Management functionality in ProCalV5 software.</td>
</tr>
<tr>
<td>Administer Calibration Users*</td>
<td>Administer users, groups, and permissions in ProCalV5 software. Note that this policy only determines if the user is automatically added to the Administrator group in the ProCalV5 software. Once the user is added to ProCalV5, changing this policy for an AssetCentre user does not change the user's ProCalV5 security permissions.</td>
</tr>
<tr>
<td>Configure Database Maintenance</td>
<td>Configure automatic database maintenance, manually analyze, or rebuild index fragmentation.</td>
</tr>
<tr>
<td>Switch to Design mode</td>
<td>Enter Design mode, in which the user can edit the asset tree.</td>
</tr>
<tr>
<td>View Event Log</td>
<td>Show the Event Log and run a search on the Event Log.</td>
</tr>
<tr>
<td>View Audit Log</td>
<td>Show the Audit Log and run a search on the Audit Log.</td>
</tr>
<tr>
<td>View Diagnostics and Health Log</td>
<td>Show the Diagnostics and Health Log and run a search on the Diagnostics and Health Log.</td>
</tr>
<tr>
<td>Change Diagnostics and Health Log Message</td>
<td>Change the status of or add a comment to a Diagnostics and Health Log record.</td>
</tr>
<tr>
<td>View Diagnostics and Health Log Status</td>
<td>View a status history for a Diagnostics and Health Log record.</td>
</tr>
<tr>
<td>Run Log Database Cleanup Wizard</td>
<td>Run the Log Database Cleanup Wizard to remove old records from the logs. Data can be exported and saved in a separate file.</td>
</tr>
<tr>
<td>Enable or Disable DTMs*</td>
<td>Enable and disable DTMs in the DTM Catalog.</td>
</tr>
<tr>
<td>Edit DTM Network*</td>
<td>Show the DTM Networks dialog box to edit the DTM network.</td>
</tr>
<tr>
<td>Create a new schedule</td>
<td>Create a schedule.</td>
</tr>
<tr>
<td>Edit a schedule</td>
<td>Change existing schedules.</td>
</tr>
<tr>
<td>Delete a schedule</td>
<td>Delete schedules.</td>
</tr>
<tr>
<td>View a schedule</td>
<td>Show the Schedules tab.</td>
</tr>
<tr>
<td>Command a schedule</td>
<td>Issue commands to a schedule, such as making the schedule active or running the schedule immediately.</td>
</tr>
<tr>
<td>Create a search</td>
<td>Set up a new search to find entries matching specified criteria in one of the logs, in the Archive History, or in Archive Check Out Status information.</td>
</tr>
</tbody>
</table>

* Starting from FactoryTalk AssetCentre version 10.00, process device capabilities are not supported. The policies marked with asterisk are only kept for viewing purposes if you have upgraded FactoryTalk AssetCentre from version 9.00 or earlier.
Chapter 12

About FactoryTalk AssetCentre Web Client

FactoryTalk AssetCentre Web Client is a web application that provides access to the FactoryTalk AssetCentre system from a web browser. As opposed to the FactoryTalk AssetCentre client with full read-and-write functions, the web client allows you to do the following to monitor your factory automation system:

- View the asset tree and archive workspace.
- Check in and check out files or binders, undo a check-out, unblock a workflow, pin, label, and promote files and binders, and copy a version from backup data to configuration data.
- View, filter, and sort logs.
- Run, stop, filter, and sort schedules.
- Run, filter, and sort searches.

We recommend that you use the TLS protocol with FactoryTalk AssetCentre Web Client. See Configure the TLS protocol for FactoryTalk AssetCentre on page 83.

Access FactoryTalk AssetCentre Web Client

You must sign in every time you try to open the web client with a browser.

To sign in to FactoryTalk AssetCentre Web Client

1. From the Start menu, select AssetCentre Web Client, or open the browser, and then enter the URL address http://<FQDN>/RockwellSoftware/AssetCentreWebClient.

   Tip: FQDN is the fully qualified domain name of the FactoryTalk AssetCentre Server computer.
   If you are changed the default port in site binding, you need to include the self-defined port number in the computer name part in the form as MYSERVER:PortNumber.

2. On the AssetCentre Web Client page, enter the user name and the password.

   IMPORTANT You can sign in to FactoryTalk AssetCentre Web Client using a FactoryTalk user or Windows-linked user.

3. Select Sign in.

Configure Idle Time-out property in Internet Information Services (IIS) Manager

When no interaction with the web client has occurred for 20 minutes, you will be automatically signed out. You can adjust the Idle Time-out property using the Internet Information Services (IIS) Manager.
To configure Idle Time-out property in Internet Information Services (IIS) Manager

1. Open Internet Information Services (IIS) Manager on the FactoryTalk AssetCentre server computer.
2. In the Connections pane, select Application Pools.
3. Under Application Pools, right-click AssetCentreWebClient, and then select Advanced Settings.
4. Do the following to configure Idle Time-out property:
   - To adjust the length of time before the user is automatically signed out:
     Adjust Idle Time-out (minutes) as desired. The default length of time is 20 minutes.
   - To prevent the user from being automatically signed out:
     Change Idle Time-out Action by selecting Suspend from the dropdown menu. The default selection is Terminate.
Uninstall FactoryTalk AssetCentre

Uninstall FactoryTalk AssetCentre software version 8.00 or later from Programs and Features in Windows Control Panel or using a command.

- Uninstall from the Control Panel on page 101
- Uninstall using a command on page 101

Tip: To uninstall FactoryTalk AssetCentre version 7.10 or earlier, use Windows Control Panel.

Uninstall from the Control Panel

To uninstall FactoryTalk AssetCentre from the Control Panel

1. Depending on how the software component was installed with the Setup wizard, the uninstallation varies.
   - If only installed with AssetCentre Server, double-click FactoryTalk AssetCentre Server 12.00.00.
   - If only installed with AssetCentre Agent, double-click FactoryTalk AssetCentre Agent 12.00.00.
   - If only installed with AssetCentre Client, double-click FactoryTalk AssetCentre Client 12.00.00.
   - If installed with AssetCentre Custom Installation, double-click FactoryTalk AssetCentre 12.00.00.
2. Select Uninstall.
3. Select Close or restart the computer.

Uninstall using a command

When uninstalling with a command, it uninstalls components that are already installed with the product specified. It does not uninstall components, such as FactoryTalk Activation Manager, that are shared with other products. You need to manually uninstall them in Control Panel.

To uninstall FactoryTalk AssetCentre using a command

1. Close all Windows programs.
2. Open the Command Prompt window.
3. In the Command Prompt window, navigate to D:, where D: is the drive containing the FactoryTalk View installation package.
   In this example, type D: and press Enter.

Tip: If User Account Control dialog box shows, click Yes.
4. Type a command with the following syntax and press Enter:
   
   `Setup.exe /Q /Uninstall /Product=product_name`

   For example, to uninstall FactoryTalk AssetCentre client, use the following command:
   
   `Setup.exe /Q /Uninstall /Product="AssetCentre Client"

The following table shows command-line parameters for this mode:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/Q</td>
<td>Required if /QS is not specified. Uninstalls the product in the silent mode without any user interface during uninstallation.</td>
</tr>
<tr>
<td>/QS</td>
<td>Required if /Q is not specified. Uninstalls the product in the unattended mode during uninstallation, and shows the progress, errors, or complete messages on the user interface.</td>
</tr>
<tr>
<td>/Uninstall</td>
<td>Required. Uninstalls components that are already installed with the product specified.</td>
</tr>
</tbody>
</table>
| /Product=product_name | Required. Specifies which product will be uninstalled.  
The parameter value must be one of the following:  
• AssetCentre Server  
• AssetCentre Client  
• AssetCentre Agent  
• AssetCentre Custom Installation |
Troubleshoot FactoryTalk AssetCentre

This chapter describes:

- **General installation** on page 103
- **Server installation** on page 103
- **Client and agent installation** on page 105
- **Start the client** on page 106
- **Start the agent** on page 112

**General installation**

**A red x appears next to an item to be installed**

The initial window in each installation (server, client, and agent) shows a list of all necessary components, whether they were found on the computer, and whether they will be installed. If the installer could not determine whether the correct version already exists on that computer, a red x is shown next to a component.

Contact Technical Support using the contact information provided on the copyright page at the beginning of this guide.

**A Program Maintenance window appears**

This indicates that the component of the software you are installing is already installed. You do not need to install it again. If you suspect your installation is damaged, you can choose to repair the installation.

**Server installation**

**SQL collation error encountered during database installation**

The SQL Server collation must be case-insensitive for use with FactoryTalk AssetCentre software. If your SQL Server collation is case-sensitive, the FactoryTalk AssetCentre database installation will fail. If your SQL Server collation is case-sensitive, see [Install Microsoft SQL Server](#) on page 19 for detailed directions.
Change the FactoryTalk AssetCentre SQL server instance

For FactoryTalk AssetCentre version 8.00 and earlier, the repair function executes the same workflow which PlantPax team uses. Since version 9.00, FactoryTalk AssetCentre starts to use the silent repair of the common install. You cannot change the FactoryTalk AssetCentre SQL server instance during repair progress. If you need to change the FactoryTalk AssetCentre SQL server instance after installing the FactoryTalk AssetCentre server software, you can follow the steps as below:

1. Install FactoryTalk AssetCentre server, client, agent, and SQL Express on a single Server 2016 instance.
2. Install SQL Server 2016 on a separated computer.
3. On the FactoryTalk AssetCentre server computer, run the utility `FTAssetCentre.DbInstaller.exe` in `C:\Program Files (x86)\Rockwell Software\AssetCentre Server\Bin\RockwellAutomation`, and then enter their SQL information which is on the separated computer.
4. Then run `FTAssetCentre.AosCatalogImport.exe` in `C:\Program Files (x86)\Rockwell Software\AssetCentre Server\Bin\RockwellAutomation`.
5. Restart FactoryTalk AssetCentre server computer. At this time, the FactoryTalk AssetCentre server has pointed to the new SQL DB server. The FactoryTalk AssetCentre server, agent, and client are working normally with new FactoryTalk AssetCentre SQL server instance.

Unable to log on to SQL Server during server installation

In FactoryTalk AssetCentre Server version 10.00.00 and later, SQL Server sa (system administrator) account is only available for silent or unattended installation.

- If you configured your SQL Server to use mixed (both SQL Server and Windows domain) authentication, the sa account is available. Use the password you created for the sa account when the installation program prompts you for it.
- If your SQL Server installation is not configured for mixed authentication, you will need to change the authentication method. See the documentation for SQL Server for more information.

Tip: New installations of FactoryTalk AssetCentre Server installation require that the Windows account of the user performing the installation, or a Windows group of which the user performing the installation is a member, is assigned the Microsoft SQL Server System Administrator role before attempting the installation. This change is optional for Upgrade installations.

- If you have forgotten your sa account password, you will need to change it. See the Microsoft SQL Server documentation for more information.

The application failed to initialize properly

This is a known issue with Symantec Endpoint Protection. When installing the FactoryTalk AssetCentre server on a computer that has Symantec Endpoint Protection version 11.0.5002.333, you may receive an error message indicating that the application you are installing fails to initialize properly.

To fix this issue

- Use a different Symantec Endpoint Protection version.
• Disable the Symantec Application and Device Controller service by following the steps below:
  a. From Windows Start menu, select All Programs > Accessories > Command Prompt.
  b. In the Command Prompt window, enter `sc config sysplant start=disabled` and press Enter.
  c. Restart the computer and try to install the server again.

Client and agent installation

Check whether the client is installed correctly

To check whether the client is correctly installed and connected to the FactoryTalk AssetCentre server

1. Click Start, and then use search to search for AssetCentre Client.
2. Click AssetCentre Client.
   FactoryTalk AssetCentre Client appears.
   When the client runs, it checks the server for the latest version of the client software. If the client software is not the latest version, the following message is displayed:
   *The client and server versions are incompatible.*
   To update the client software, follow the Steps to install the FactoryTalk AssetCentre Client software on page 40 at the start of Chapter 4.
   For information on getting started with the software, see the FactoryTalk AssetCentre Getting Results Guide.

Check whether the agent software is current

Unlike the FactoryTalk AssetCentre client, the FactoryTalk AssetCentre agent does not show a message if the agent does not have the latest version of the software. Instead, the agent does not start, and logs a message in the System Event log and the AssetCentre Event log.

To check whether the FactoryTalk AssetCentre software on the agent is up to date

1. Click Start, and then use search to search for AssetCentre Client.
2. Click AssetCentre Client.
   FactoryTalk AssetCentre client appears.
3. Check the number of running agent computers.
   It is displayed in the bottom right corner of the window on the status bar. If one or more agents are not running, and the client software has been recently updated, then the agent software may need to be updated as well.
   To update the agent software, follow the Steps to install the FactoryTalk AssetCentre Agent software on page 32.
**Error reading Primary Server Name from FactoryTalk Directory**

This error occurs when the computer on which you are installing the client is not using the same FactoryTalk Directory as the computer running the FactoryTalk AssetCentre server, or there was an error in the FactoryTalk Services Platform.

**To solve this problem**

1. On the FactoryTalk AssetCentre server computer, set the FactoryTalk Directory location.
   
   From **Windows Start** menu, select **All Programs > Rockwell Software > FactoryTalk Tools > Specify FactoryTalk Directory Location**.

2. Log in if prompted to do so, and then specify the location of the FactoryTalk Directory.
3. Close any clients that are connected to the server.

**Logged in user is not part of the Administrators group**

Currently logged in Windows user is not part of the Administrators group.

To resolve this problem, make sure you are installing the software as an administrator, or a user with administrative privileges.

**Start the client**

**Error initializing FactoryTalk AssetCentre**

The FactoryTalk AssetCentre server may have failed (or you may have lost your network connection to the server), or the computer on which you installed the client may not be part of the FactoryTalk Directory.

**To solve the problem**

- Check the server (see Other errors starting the client on page 111).
- Try adding the client computer to the FactoryTalk Network Directory. From another computer that has access to the FactoryTalk Directory (the FactoryTalk AssetCentre server, for example), use the FactoryTalk Administration Console to add the computer to the FactoryTalk Directory. See Add computers to the FactoryTalk Directory on page 94.
- See If the FactoryTalk AssetCentre server is installed to a drive other than C on page 111.
Error initializing FactoryTalk AssetCentre: unable to connect to the remote server

When starting the FactoryTalk AssetCentre client, you may get the following error:

![Error message](image)

The error message may appear when you have checked the **Use the secure communication channel** option in the Configure Server Settings Utility window, but you haven't configured the SSL protocol.

**To solve the problem**

- Configure the SSL protocol.
  
  See [Configure the SSL protocol for FactoryTalk AssetCentre](page 83).

- Clear the **Use the secure communication channel** check box in the Configure Server Settings Utility window, if you don't want to use the SSL protocol.

Error initializing FactoryTalk AssetCentre: the underlying connection was closed

When starting the FactoryTalk AssetCentre client, you may get the following error:

![Error message](image)
The error message may appear in the following cases:

- You have provided an incomplete fully qualified domain name (FQDN) of the FactoryTalk AssetCentre server computer in the **Configure Server Settings Utility** window for the SSL configuration.
- You haven’t added the certificate authority that issued the SSL certificate to the Trusted Root Certification Authorities certificate store for the SSL configuration.

**To solve the problem**

- Make sure that the fully qualified domain name (FQDN) of the FactoryTalk AssetCentre server computer in the Configure Server Settings Utility window is complete.
  
  See *Turn on secure communication between the server, client(s) and agent(s)* on page 123.

- Add the certificate authority that issued the SSL certificate to the Trusted Root Certification Authorities certificate store for the SSL configuration.
- See *Import the SSL certificate to client and agent computers* on page 123.

**Error initializing FactoryTalk AssetCentre: the remote server returned error (404) Not Found**

When starting the FactoryTalk AssetCentre client, you may get the following error:

![Error message](image)

The error message may appear when you have misspelled the fully qualified domain name (FQDN) of the FactoryTalk AssetCentre server computer in the site binding for the SSL configuration in the Internet Information Services (IIS) Manager.

**To solve the problem**

- Correct the spelling of the fully qualified domain name (FQDN) of the FactoryTalk AssetCentre server computer in the site binding.
  
  See *Configure a site binding* on page 118.
Error initializing FactoryTalk AssetCentre: the remote name could not be resolved

When starting the FactoryTalk AssetCentre client, you may get the following error:

The error message may appear when you have misspelled the fully qualified domain name (FQDN) of the FactoryTalk AssetCentre server computer in the Configure Server Settings Utility window for the SSL configuration.

To solve the problem

- Correct the spelling of the fully qualified domain name (FQDN) of the FactoryTalk AssetCentre server computer in the Configure Server Settings Utility window.

See Turn on secure communication between the server, client(s) and agent(s) on page 123

Error initializing FactoryTalk AssetCentre: the remote server returned an error (401) Unauthorized

When starting the FactoryTalk AssetCentre client, you may get the following error:
The error message may appear when you have enabled Windows Authentication for FactoryTalk AssetCentre computers that are not added to a Microsoft Active Directory, and the local account with which you are starting the client doesn't exist on the remote FactoryTalk AssetCentre server computer to which the client is trying to connect.

**To solve the problem**

- On the remote FactoryTalk AssetCentre server computer, add an account that has the username and the password identical with the local account credentials that were used to start the FactoryTalk AssetCentre client.

  See Configure Windows Authentication on page 89

**The client and server versions are incompatible**

The FactoryTalk AssetCentre software installed on the server has been updated, and the software on the client needs to be updated. See Check whether the client is installed correctly on page 105.

**Cannot initialize application eventing subsystem or No connection could be made because the target machine actively refused it**

If you see the error *Cannot initialize application eventing subsystem*, or an error indicating that the target machine actively refused the connection, then:

- Make sure the FactoryTalk AssetCentre Server service is started on the server computer.
- Restart the client computer.
- If you still see the error, stop and disable all schedules. Restart the FactoryTalk AssetCentre server computer.

  **IMPORTANT** While the server is restarting other users will not be able to edit the asset tree, create or edit schedules and searches, view information in the logs, and so on. Also, most data will not be logged during the reboot. The exception is audit data generated by other software products such as RSLogix software, which is cached and will appear in the audit log when the server comes back online.

- See If the FactoryTalk AssetCentre server is installed to a drive other than C: on page 111.

**At least one service or driver failed during system startup. Use Event Viewer to examine the event log for details**

This message may appear when launching RSLinx Classic on a system that has both RSLinx Classic and FactoryTalk Linx, formerly known as RSLinx Enterprise, installed. The System Event log contains the message, *The A-B Virtual Backplane service failed to start due to the following error: The system cannot find the file specified.*

In some cases, the Virtual Backplane driver does not get installed correctly. For more information, see the Knowledgebase Document ID: BF16472 - AB Virtual Backplane Failed to Start Message.
If the FactoryTalk AssetCentre server is installed to a drive other than C:

If the server was installed to a drive other than C, and necessary permissions to the Users group were removed on that drive, you may encounter error messages when starting the client. The FactoryTalk AssetCentre Server service will be stopped and, if you attempt to manually start it, will fail to start.

To rectify this problem, you must set permissions for the Users group on that drive as follows:

1. On the server computer in Windows Explorer, or My Computer, navigate to the Program Files folder on the drive, on which the FactoryTalk AssetCentre server was installed.
2. Right-click the Rockwell Software folder and select Properties.
4. Add the group Users (computername\Users) if it is not in the list. If it is in the list, skip to step 5.
   To add the Users group:
   a. Click Add.
   b. Make sure the local computer name appears in the From this location field.
   c. In the Enter the object names to select field, type:
      Users
   d. Click Check Names, then OK.
5. Select the group Users (computername\Users).
6. Set the Read & Execute, List Folder Contents, and Read permissions to Allow.

Other errors starting the client

If the client won’t start or you see other error messages not specifically mentioned above, try the following:

- Make sure the client computer is connected to the network, and the network is operational.
- Make sure the FactoryTalk AssetCentre server computer is running.
- Make sure the FactoryTalk AssetCentre Server service, IIS, and SQL Server are all running on the server computer (and the database computer if separate). To check IIS, see To make sure IIS is running on the server computer.
- Make sure the correct FactoryTalk Directory is specified. On the machine running the client, from Windows Start menu, select All Programs > Rockwell Software > FactoryTalk Tools > Specify FactoryTalk Directory Location.
- If you are running in an environment without a domain controller (in a workgroup), you may need to turn off the single sign-on feature of FactoryTalk. See the FactoryTalk Help for more information.
- Make sure the server location setting is correct. On the server computer, from Windows Start menu, select All Programs > Rockwell Software > FactoryTalk AssetCentre Server > Server Settings. The server location must be set in this utility, NOT in the FactoryTalk Administration Console.
- Make sure the SQL Connection is set properly. On the server computer, from Windows Start menu, select All Programs > Rockwell Software > FactoryTalk AssetCentre Server > Data Source Configuration.
• If you are using a firewall, make sure your firewall is configured properly to permit access to the FactoryTalk AssetCentre Server. See Network requirements on page 17, and Knowledgebase Document ID: BF7490 - TCP/UDP Ports Used by Rockwell Automation Products.

Start the agent

If the FactoryTalk AssetCentre software installed on the server has been updated, the agent will not start until the software on the agent is updated. See Check whether the agent software is current on page 105.
Appendix A

Configure the TLS protocol using a self-signed certificate

If you don’t have a TLS certificate signed by certificate authority (CA), you need to create a self-signed TLS certificate on the FactoryTalk AssetCentre Server computer. After importing the TLS certificate to the Management of Change, FactoryTalk AssetCentre Server, Agent, and Client, and FactoryTalk AssetCentre Web Client computers, you must configure a firewall rule and web services URL if the default port is modified on page 84.

The configuration including these steps:

- Create an TLSL certificate on page 113
- Export the created TLS certificate for FactoryTalk AssetCentre client and agent computers on page 116
- Configure a site binding on page 118
- Configure SSL settings for FactoryTalk AssetCentre Web Client on page 120
- Turn on secure communication between the server, client(s), and agent(s) on page 123
- Import the TLS certificate to client and agent computers on page 123

Create a self-signed TLS certificate

Follow these steps to create a self-signed TLS certificate on the FactoryTalk AssetCentre Server computer.

**To create an TLS certificate**

1. Open Internet Information Services (IIS) Manager on the FactoryTalk AssetCentre server computer.
   a. On the taskbar, click [ ]
   b. In the search box, type `inetmgr`, and then press **Enter**.
c. Click the best match result.

2. Under **Connections**, click the FactoryTalk AssetCentre server.

3. In **Features View**, double-click **Server Certificates**.
4. Under **Actions**, click **Create Self-Signed Certificate**.

![Actions menu](Image)

5. In the **Create Self-Signed Certificate** dialog box:
   - Specify a name for the certificate.
   - Select **Web Hosting** as the certificate store.

![Create Self-Signed Certificate dialog box](Image)

6. Click **OK**.

The created TLS certificate is listed.

![Server Certificates](Image)
Export the created TLS certificate for FactoryTalk AssetCentre client and agent computers

After creating an TLS certificate on the FactoryTalk AssetCentre server computer, export the certificate which will need to be imported on the FactoryTalk AssetCentre client and agent computers.

To export the created TLS certificate

1. Open Internet Information Services (IIS) Manager on the FactoryTalk AssetCentre server computer.

   a. On the taskbar, click  
   b. In the search box, type inetmgr, and then press Enter.
   c. Click the best match result.

2. Under Connections, click the FactoryTalk AssetCentre server.
3. In **Features View**, double-click **Server Certificates**.

![Server Certificates in Features View]

4. Select the TLS certificate that you have created.

5. Under **Actions**, click **Export**.

![Actions in Features View]

6. In the **Export Certificate** dialog box:
   
   - Under **Export to**, click ..., and then specify the location and name to save the certificate.
   - Specify the password for the certificate.

7. Click **OK**.
Configure a site binding

Before you begin

- Create a self-signed TLS certificate on page 113.

To configure a site binding

1. Open Internet Information Services (IIS) Manager on the FactoryTalk AssetCentre server computer.
   
   a. On the taskbar, click .
   b. In the search box, type inetmgr, and then press Enter.
   c. Click the best match result.

2. Navigate to localhost > Sites > Default Web Site.
3. Under **Actions**, click **Bindings**.

![Image of Actions menu with Bindings highlighted]

4. In the **Site Bindings** dialog box, click **Add**.

![Image of Site Bindings dialog box with Add button highlighted]

5. In the **Add Site Binding** dialog box, configure the following settings.

<table>
<thead>
<tr>
<th>For this option...</th>
<th>Do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select https.</td>
</tr>
<tr>
<td>IP address</td>
<td>Select All Unassigned.</td>
</tr>
</tbody>
</table>
For this option... | Do this...
---|---
Port | Keep the default port number 443 or if you needed, you may change it to a self-defined port. If you use a self-defined port, you need to configure a firewall rule and web services URL on page 84.
Host name | Type the fully qualified domain name (FQDN) of the FactoryTalk AssetCentre server.
SSL certificate | Select your TLS certificate. See Create a self-signed TLS certificate on page 113.

6. Click **OK**.
7. In the **Site Bindings** dialog box, the created site binding is listed. Click **Close**.

Tip: You can remove the default HTTP site binding and only keep the created HTTPS site binding.

Configure SSL settings for Management of Change, FactoryTalk AssetCentre Client and Agent, and FactoryTalk AssetCentre Web Client

**Before you begin**
- Create a self-signed TLS certificate on page 113.
- Configure a site binding on page 118.

**To configure SSL settings for Management of Change, FactoryTalk AssetCentre Client and Agent, and FactoryTalk AssetCentre Web Client**

1. Open Internet Information Services (IIS) Manager on the FactoryTalk AssetCentre server computer.
   a. On the taskbar, click ![taskbar icon](image)
   b. In the search box, type *inetmgr*, and then press **Enter**.
c. Click the best match result.

2. Navigate to **localhost > Sites > Default Web Site**.

To configure the SSL settings for Management of Change, select **LLumin**.
To configure the SSL settings for FactoryTalk AssetCentre Client and Agent, and FactoryTalk AssetCentre Web Client, select **AssetCentre** and **AssetCentreWebClient** under **RockwellSoftware**.
3. In **Features View**, double-click **SSL Settings**.

4. Make sure the following options are selected:
   - **Require SSL**
     (FactoryTalk AssetCentre Web Client only) Selecting this option will result in deactivating the HTTP protocol (with the default port 80). When you type `http://` in the web browser, it will be automatically redirected to `https://`.
   - **Ignore**
     This option applies to the client certificates.

5. Under **Actions**, click **Apply**.
6. Restart the computer.

Turn on secure communication between the server, client(s), and agent(s)

Once you configured the TLS protocol, turn on secure communication between the server, client(s), and agent(s) in the Configure Server Settings Utility window.

To enable secure communication

1. Open the Configure Server Settings Utility window.
     a. On the taskbar, click 📚.
     b. In the search box, type Server Settings.
     c. Click Server Settings.
2. Enter the user name and password to log on to FactoryTalk, and then click OK.
   - In the Configure Server Settings Utility window, under Server Location, the domain name (FQDN) of the FactoryTalk AssetCentre server computer will be detected automatically.
3. Select the Use the secure communication channel option.
4. Click OK.

Import the self-signed TLS certificate to client and agent computers

On the client and agent computers, add the self-signed TLS certificate to the Trusted Root Certification Authorities certificate store.

Before you begin

- [Create a self-signed TLS certificate](#) on page 113.
• Export the created TLS certificate on page 116.

To import the self-signed TLS certificate on operating systems

1. Copy the created TLS certificate on the computer.
2. Double-click the TLS certificate.
3. Select Local Machine, and then click Next.

4. When prompted to confirm the operation, click Yes.
5. Follow the on-screen instructions until you get to the Certificate Store screen.
6. On the **Certificate Store** screen, select **Place all certificates in the following store**.

7. Click **Browse**, select **Trusted Root Certification Authorities**, and then click **OK**.
8. Click **Next**.

9. Follow the on-screen instructions to complete the import.

**To verify the import operation**

1. Click **Start**, type `mmc`, and then press **Enter**.
   
   The Microsoft Management Console opens.

2. Click **File > Add/Remove Snap-in**.
3. In the **Add or Remove Snap-ins** dialog box, select **Certificates**, and then click **Add**.

![Add or Remove Snap-ins](image1)

4. In the **Certificates snap-in** dialog box, select **Computer account**, and then click **Next**.

![Certificates snap-in](image2)
5. Click **Finish**.

6. In the **Add or Remove Snap-ins** dialog box, click **OK**.
7. In the Microsoft Management Console, navigate to **Console Root > Certificates (Local Computer) > Trusted Root Certification Authorities > Certificates**, and verify that the TLS certificate is listed.

8. If the TLS certificate is not listed, make sure to select **Certificates** under **Trusted Root Certification Authorities > Certificates**, and then click **Action > All Tasks > Import**.

9. Follow the on-screen instructions to complete the import.
Legal Notices

Rockwell Automation publishes legal notices, such as privacy policies, license agreements, trademark disclosures, and other terms and conditions on the Legal Notices page of the Rockwell Automation website.

End User License Agreement (EULA)

You can view the Rockwell Automation End User License Agreement (EULA) by opening the license.rtf file located in your product’s install folder on your hard drive.

The default location of this file is:

    C:\Program Files (x86)\Common Files\Rockwell\license.rtf.

Open Source Software Licenses

The software included in this product contains copyrighted software that is licensed under one or more open source licenses.

You can view a full list of all open source software used in this product and their corresponding licenses by opening the oss_license.txt file located in your product’s OPENSOURCE folder on your hard drive. This file is divided into these sections:

- Components
  Includes the name of the open source component, its version number, and the type of license.

- Copyright Text
  Includes the name of the open source component, its version number, and the copyright declaration.

- Licenses
  Includes the name of the license, the list of open source components citing the license, and the terms of the license.

The default location of this file is:

    C:\Program Files (x86)\Common Files\Rockwell\AssetCentre\ReleaseNotes\OPENSOURCE\n
You may obtain Corresponding Source code for open source packages included in this product from their respective project web site(s). Alternatively, you may obtain complete Corresponding Source code by contacting Rockwell Automation via the Contact form on the Rockwell Automation website: http://www.rockwellautomation.com/global/about-us/contact/contact.page. Please include "Open Source" as part of the request text.
Index

A
Access to features 95
Administrator rights 19
Agents 12
agent does not run 105
Disaster Recovery, install 32
install 31
not start 112
system requirements 13
update from server 105

C
Capabilities 31
Checklists 19
Clients 12
error starts 106
install 40
run 105
system requirements 14, 15
update from server 105
Computers 94
Configure
Access to features 95
client computers 94
security 95
security and RSLogix 35
Users 93

D
Device Type Manager 11
Disaster Recovery 32
DriveExecutive Lite 14

E
Error Messages
At least one service or driver failed during system startup 110
Cannot initialize application eventing subsystem 110
Currently logged in Windows user is not part of the Administrators group 106
Error initializing FactoryTalk AssetCentre 106
the remote name could not be resolved 109
the remote server returned an error (401) Unauthorized 109
the remote server returned error (404) Not Found 108
the underlying connection was closed 107
Error reading Primary Server Name from FactoryTalk Directory 106
If the FactoryTalk AssetCentre server is installed to a drive other than C: 111
Target machine actively refused the connection 110
The application failed to initialize properly 104
The client and server versions are 110

F
FactoryTalk Administration Console 93
FactoryTalk AssetCentre agents 12
install 31
not start 112
requirements 13, 14
FactoryTalk AssetCentre clients 12
error starts 106
install 40
requirements 13, 14
run 105
FactoryTalk AssetCentre server 12
error starts 106
install 19, 26, 43
requirements 13
FactoryTalk Directory
access via 93
add computers 94
add users 93
FactoryTalk Security
configure 95
RSLogix and 35
Feature security 95
File and Printer Sharing setting 19
Firewall
configure for 17
IIS and 19
TCP/IP ports 17

H
Hardware requirements 13
agent computer 14, 15
clients 14, 15
server 13

I

IIS
firewall and 19
Install
FactoryTalk AssetCentre agents 31
FactoryTalk AssetCentre clients 39
FactoryTalk AssetCentre server 19, 26, 43
log on as administrator 19
SQL Server 2008 19
Troubleshoot 19

L
Logix Designer 14, 35

N
Network requirements 17

P
Ports
needed for FactoryTalk AssetCentre 17
TCP/IP 17

R
RAID-5 13
RSLogix
agents and 32
security and 35

S
Security
add users 93
configure 95
RSLogix and 35
Server 12
install 19, 26, 43
requirements 13
Server Settings 95
Siemens, editors for
SIMATIC Manager 14
SIMATIC NET 15
Software requirements 13
agent computer 14, 15
clients 14, 15

T
TCP/IP 17
Troubleshoot 19

U
Update message when starting client 105
Upgrade from earlier versions 47
Users 93

W
Windows Authentication
configure 89
turn on 89
Windows Firewall 19
Windows Vista 12
Rockwell Automation support

Use these resources to access support information.

<table>
<thead>
<tr>
<th>Technical Support Center</th>
<th>Find help with how-to videos, FAQs, chat, user forums, and product notification updates.</th>
<th>rok.auto/support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledgebase</td>
<td>Access Knowledgebase articles.</td>
<td>rok.auto/knowledgebase</td>
</tr>
<tr>
<td>Local Technical Support Phone Numbers</td>
<td>Locate the telephone number for your country.</td>
<td>rok.auto/phonesupport</td>
</tr>
<tr>
<td>Literature Library</td>
<td>Find installation instructions, manuals, brochures, and technical data publications.</td>
<td>rok.auto/literature</td>
</tr>
<tr>
<td>Product Compatibility and Download Center (PCDC)</td>
<td>Get help determining how products interact, check features and capabilities, and find associated firmware.</td>
<td>rok.auto/pcdc</td>
</tr>
</tbody>
</table>

Documentation feedback

Your comments help us serve your documentation needs better. If you have any suggestions on how to improve our content, complete the form at rok.auto/docfeedback.

Waste Electrical and Electronic Equipment (WEEE)

At the end of life, this equipment should be collected separately from any unsorted municipal waste.

Rockwell Automation maintains current product environmental information on its website at rok.auto/pec.